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END USER LICENSE AGREEMENT

IMPORTANT-READ CAREFULLY: Below you will find the contractual
agreements governing the use of this imaging Software. These conditions
apply to you, the user, and to OLYMPUS SOFT IMAGING SOLUTIONS
GmbH. With any of the following actions you explicitly agree to be bound
by the conditions of this contract: purchasing the Software, opening the
package, breaking of one of the seals or using the Software.

In case you do not agree with any of the conditions of this contract,
please return all parts of the Software including manuals, the license
certificate and/or the Software protection key before using and without
delay. Remove all Software installations of the Software from any
computer you might have installed it on. Return all electronic media of the
Software or completely destroy all electronic media of the Software and
send proof that this has been accomplished. For a refund, please return
everything to where you purchased the Software.

1. Scope

(1) This License Agreement explicitly covers only the Software diskettes
or other media you received with the purchase and the Software stored
on these media, the manuals, the license certificate and/or the Software
protection key, together referred to as “Software”, as far as they were
developed and produced by OLYMPUS SOFT IMAGING SOLUTIONS
GmbH.

(2) The Software may be modified or enhanced by OLYMPUS SOFT
IMAGING SOLUTIONS GmbH or its licensors for debugging, upgrading
or any other purposes. The Software shall contain such modified or
enhanced version. You can only use either the previous version or the
modified or enhanced version and cannot use both of the versions. You
have, however, no right to receive modifications or enhancements or
upgrades, unless those are provided for warranty purposes and you have
a legitimate claim towards warranty.

(3) The Software may include (i) some open source software and (ii) other
third party software (collectively, "Third Party Software"). Regarding the
use of the Third Party Software, you shall follow the license terms and
conditions applied to such Third Party Software. Any part of this
Agreement does not restrict, change or alter any of your rights and
obligations imposed by the license terms and conditions of the Third Party
Software.

2. User rights

(1) OLYMPUS SOFT IMAGING SOLUTIONS GmbH permits the User,
for the duration of this contract, to use the Software on a single computer
and a single terminal on that computer within the Territory of installation.
This license is explicitly non-exclusive, i.e., the User does not have an
exclusive right to use the Software. As a licensed user you can copy the
Software from one computer to another by using a computer network or
other storage devices, as long as it is assured, that the Software can only
be used on a single computer and terminal at any time and that the
conditions set forth under 4 are observed. For the purpose of this
License, the term Territory shall mean (i) for installations in a member
state of the European Union: all member states of the European Union
and (ii) for installations in a country outside of the European Union: the
country in which the computer is located on which the Software is
installed.

(2) The User has the right to produce a copy of the Software only for
backup purposes.

(3) The Software is provided with a license certificate or a dongle. It is
the responsibility of the owner to take care of the license certificate and/or
of the dongle. In case of loss, neither the license certificate nor the dongle
will be replaced by OLYMPUS SOFT IMAGING SOLUTIONS GmbH.

3. Transfer

You may permanently transfer all of your rights under this Agreement only
if the recipient agrees to the terms and conditions of this Agreement and if
you destroy and will not keep any copies of the Software in your
possession.

4. Copyright

OLYMPUS

(1) OLYMPUS SOFT IMAGING SOLUTIONS GmbH or its subsidiaries
remain owners of the copyright to the Software and its documentation.
With the purchase, the User obtains ownership of the diskettes or other
physical storage devices (excluding the Software and other data
contained thereon), the manuals, and the license certificate and/or the
Software protection key. Furthermore, a right to use the Software as
defined in Sec. 2 will be granted.

(2) OLYMPUS SOFT IMAGING SOLUTIONS GmbH reserves the right
to all publications, duplication, editing, and marketing of the Software and
the Software documentation.

Without prior written permission the User may not:

« change, translate, de-compile or de-assemble the Software,

«  copy any of the written or printed documentation of the Software,

« rent, lease, or license the Software to a third party,

« use the Software protection different than described in this contract.

(3) OLYMPUS SOFT IMAGING SOLUTIONS GmbH is the legal owner of
all copyrights and trademarks of the Software and documentation.
Copyrights and trademarks are protected by national and international
law. OLYMPUS SOFT IMAGING SOLUTIONS GmbH reserves all rights,
which are not explicitly expressed in written form.

5. Warranty

(1) OLYMPUS SOFT IMAGING SOLUTIONS GmbH warrants that the
Software delivered under this Agreement for the period of 12 months of
the date of purchase works in all major aspects according to the
descriptions in the specification. OLYMPUS SOFT IMAGING
SOLUTIONS GmbH shall not be liable for the Software being suitable for
a particular purpose unless otherwise agreed upon to which you intend to
put it.

(2) This warranty does not cover defects in the Software which are due
to improper installation or changes to the program which you have
undertaken.

(3) OLYMPUS SOFT IMAGING SOLUTIONS GmbH does not warrant,
that the Software is defect free, that the Software fulfills the specific
requirements of the User, or that the Software works with other Software
provided by the User.

(4) Where any claim in respect to the Software which is based on any
defect in the quality or condition of the Software to meet the specification
is notified to OLYMPUS SOFT IMAGING SOLUTIONS GmbH in
accordance with these conditions, OLYMPUS SOFT IMAGING
SOLUTIONS GmbH shall be entitled at its own discretion to either replace
the Software free of charge or repair the Software. Should OLYMPUS
SOFT IMAGING SOLUTIONS GmbH fail to repair the Software within a
reasonable time frame more than three times, the customer is entitled to
resign from this contract.

(5) The warranty is provided by OLYMPUS SOFT IMAGING
SOLUTIONS GmbH under the condition that the total price for the
Software has been paid by the due date.

(6) You are obligated to establish sufficient precautions for the case of
Software malfunctions (for example by regular data storage, frequent
backups, verification of results, emergency planning). It is your
responsibility to provide a suitable system environment.

6. Liability

(1) Whatever the legal grounds, liability for damage claims based only
on ordinary negligence against OLYMPUS SOFT IMAGING SOLUTIONS
GmbH (including its vicarious agents) shall exist only if OLYMPUS SOFT
IMAGING SOLUTIONS GmbH breaches a basic/cardinal obligation under
this Agreement. In this event the amount of the claims are limited to
typical and foreseeable damages. In cases of gross negligence the
liability shall be limited to the amount the User paid for the Software.

(2) Nothing in this clause shall affect personal injury and property
damage claims based on reasons of product liability.
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7. Contract duration, legal consequences of violating the license

(1) The contract is deemed to be in force for an unspecified period. The
User rights are automatically terminated if one of the conditions of the
contracts has been violated.

(2) In case of a contract violation the User has to return the original
storage devices and all copies thereof including all modified copies, all
printed and written documentation, as well as the license certificate
and/or the Software protection key to OLYMPUS SOFT IMAGING
SOLUTIONS GmbH, or the User has to destroy these items.

(3) Inaddition OLYMPUS SOFT IMAGING SOLUTIONS GmbH reserves
the right to file a lawsuit to claim reparations for damages, non-
compliance, or removal of the Software in case of license violations. The
following laws and/or conditions are in effect: the conditions of this
contract, copyright laws, and the laws of the German civil code (BGB).

8. Applicable Law, Place of Performance and Jurisdiction

This Agreement shall be governed by German law. The Convention on
Contracts for the International Sale of Goods (CISG) shall not apply.
Place of Performance and Jurisdiction shall be at Munster, Germany.

9. Severability

In the event a provision of this Agreement is or becomes invalid or should
this Agreement be incomplete, the validity of the remaining provisions
shall not be affected thereby. The invalid or incomplete provision shall be
substituted or supplemented, respectively, by an appropriate one
reflecting - to the extent legally permissible - as closely as possible what
the parties hereto had originally intended or would have intended
according to the sense and purpose of this Agreement, if the specific
issue had been taken into consideration by them

(2) In case of a contract violation the User has to return the original
storage devices and all copies thereof including all modified copies, and
all printed and written documentation to OLYMPUS SOFT IMAGING
SOLUTIONS, or the User has to destroy these items.

(3) In addition OLYMPUS SOFT IMAGING SOLUTIONS reserves the
right to file a lawsuit to claim reparations for damages, non-compliance, or
removal of the software in case of license violations. The following laws
and/or conditions are in effect: the conditions of this contract, copyright
laws, and the laws of the civil code.
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1 Introduction

Thank you very much for purchasing Olympus Soft Imaging Solutions’ High Content Screening System
and for your confidence in our products and service.
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The scan® Acquisition Software controls the hardware components of the Olympus scan® Screening
Station for Life Sciences. The scan® Acquisition Software is designed for automated image acquisition of
biomedical samples. The acquired images can be optimally analyzed with the scan® Analysis Software.
The software is intended for the use in biomedical research.

The scan® Analysis Software, the scan® Acquisition Software as well as the hardware
components of the Olympus scan® Screening Station for Life Sciences are for research use
only.

1.1 Abstract

This user manual will guide you through the usage of the Olympus Screening Station and will assist you
in setting up efficient and reliable screens.

The Screening System scan” is intended to be used for the screening of well-plates and slides. Do not
use the system in other ways than described in this manual.

For detailed information on the individual system hardware components please refer to the
corresponding manuals delivered with the system.

Special care has been taken to guarantee correct and accurate information, although this is subject to
changes due to further development of the Screening System. Thus, the manufacturer cannot assume
liability for any possible errors. We would appreciate reports of any mistakes as well as suggestions or
criticism.

Please refer to the respective hardware component manuals for regulatory compliances.

1.2 Technical support

If you find any information missing in this manual or you need additional support, please contact an
Olympus specialist directly.

1.3 Safety precautions

Before operating the screening system, make sure that you have carefully read and understood all
hardware component manuals and the safety precautions found in the respective manuals.
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2 Short Step-by-Step Guide

This chapter gives a step-by-step guide on how to use the scan® software to perform a basic scan.
Detailed explanations of the entire setup and acquisition procedure can be found in the following

Chapters.
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Performing a scan: A short step-by-step guide

This step-by-step guide assumes you have established scan settings for the type of sample to be
screened. If you use new types of well plates, new types of samples, new staining or staining protocols
or if you alter the optical hardware configuration, you probably have to set up new scan settings to
obtain optimal results. In that case this step-by-step guide will be insufficient for your needs. The
necessary information on how to set up new scan settings can be found in the following chapters.

Before the start

Be sure to have switched on all system devices before starting the scan® software.

Start the scan® Acquisition software

Start the scan® Acquisition software by double-clicking the scan® Acquisition icon on the desktop.

Checking hardware components

Checking hardware components...

Upon start, the software will check the availability and status of all hardware components and inform you
if one of the components is not available. In that case switch on the missing device and execute the
command Settings » Initialize Devices in order to initialize all devices without re-starting the software.
In case of any problems starting the scan® Screening Station, please refer to Chapter 8 (System
Configuration).

The software will inform you that it is going to calibrate the stage and ask you to confirm. Remove any
obstacles from the stage's operating range and press the OK button. The stage calibration will take a
few seconds.

B stage - *

Your stage will now be calibrated.
Please make sure that the whole travel range is freely accessible.

Cancel

Load or reuse scan settings

Upon starting the software the settings of the previous scan will be loaded automatically. In order to use
settings of earlier scans, use the File » Open Scan command. By default the file selection dialog will
show the settings directory of the user currently logged onto the system. Open one of the files in this
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directory or navigate to the location of a previous scan and open the respective
experiment_descriptor.xml file.

The experiment_descriptor.xml of a previous scan will use the filter and objective positions
@ specified there. If a different hardware configuration is used for the new scan, the settings
might have to be adapted accordingly (see following chapters).

Load the Well Plates

In case of a scan” system without automatic plate loader (or if the plate loader is not to be used) place
the plate manually on the microscope stage.

In order to use the automatic plate loader, place one or multiple plates in the hotels (stacker or shelves).

The automatic plate loader is designed for safe, reliable operation. Please refer to the scan®
Hardware and Software manual for safety requirements. Always wear safety goggles when
operating the system with plate loader robot. Never place any items on the base plate in the
robot operation range.

Specify and label the wells and the sample

Click the Scan: Edit button (or execute the File » Edit command) to open the Edit Scan window.
The Plate Manager tab of the current scan settings will open.

Enter a name in the Plate name box. If the plate name remains unchanged in the course of consecutive
scans, the scan directories will be stored with an incremented numeration appended to the name.
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B Edit Scan

Plate Manager  SW-Autofocus  Acquisition

Left click to toggle wells on/off
Mouse-drag (+ Ctrl) to select (deselect) wells

|E|Meander wells Wells selected 60

Well diameter [pm 6497
[ continuous zoc [um] 6497

Plate
CellCycle HelLa Edit selection table

Type
96w Edit plate types

Calibration status: A1 position calibrated
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Positions in well

Del key removes
selected positions Om

Full in

Acquisition order

Show order

(-,

Spacing

Celumn spacing [um]

666

cing [pm]

Field of view [um x um]

Total positions
52

Cancel

Select wells for acquisition by clicking on the circles that represent the wells. Deselect by clicking again.

Multiple wells can be selected by dragging the mouse over them while the mouse button is pressed
down. Deselect wells by dragging the mouse while pressing the Ctrl -key.

Click Edit selection table to get a list of the selected well numbers and their Names or Descriptions.
The names can be changed to describe the well content for later reference.

Confirm the settings and exit the Edit Scan dialog by clicking OK.

Start the Screen

source, screening can start immediately.

0 The burner of the MT20 light source (optional) will be ignited automatically after system and
software startup. It is recommended to allow a warm-up time of 10 min to let the light output
stabilize before starting the first screening run. If the system is equipped with an LED light

Start the screen by clicking the Start button on the main window. In case of automatic plate loader
operation, please select the Operate » Plate Loader Batch Scan and press the Start button there.

The following steps depend on the available hardware and calibration of the well plate.
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o |If the hardware autofocus option is available for your system or the focus position has been pre-
calibrated, and standard plates with a defined position of well Al are used, scan® will carry out the
scan without further user input.

« If no hardware autofocus is available, scan® asks the user to set the starting focus position manually.
Afterwards the scan will be carried out automatically.

« If spotted slides or other sample holders without defined starting positions are used, scan® asks the
user to move interactively to the center of the first well before the scan can commence.

The Plate Loader Batch Scan requires the use of fully calibrated plates and will always start without
further user interaction.

scanR Acquisition - [m] pd

Fle View Operst System About

T

RGB-Overlay k
verlay &

-~

20482048 0.17X 138  (281,719)

Online observation
3101112

Browse Images

Settings Autofocus

Well 49 of o5 Position 1 of 1 Cyde 1 of Time remaining: 00:06 h:min Progress:

The scan can be paused or canceled by pressing the Pause or Stop button. The system will finish
acquisition of the current position before the scan is paused or stopped. When a scan is stopped in auto
loader operation, the user can decide if the system shall continue with scanning the remaining plates or
not.
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3 Main User Interface

Chapter 3 — Main User Interface

This chapter explains the features of the image displays and briefly introduces the different menu points

and buttons accessible from the main user interface.

3.1  Front-panel displays.......cccccccceevnnivrrnennnnn.
3.2 Display Context MeNU.........ccceevvivvvvnnnnnn.
3.3 BUHONS...cooii

3.4  Microscope control and Live View

3.4.1 Microscope Settings.......cccccceeeevvvivvveeennnn.
3.4.2 ZTOCUS cooeeeeeiiiiiieee et
3.4.3 XY navigation........ccccceeevvvirreeeeeesiiinieeenn.
35 MENUS .oooiiiii

11
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3.1 Front-panel displays

scanR Acquisition - m} x

File View Operte System About

80.17X138 (281,719)
Online observation

3101112
Browse Images

Settings Autofocus

Well 49 6 Position 1 of 1 Cyde 1 of 1 Plate 1 Time remaining: 00:06 h:min

The main window features one large and three small live image displays by default. This allows to
separately observe different color channels, a multicolor channel overlay (RGB Overlay +
Transmission) or an online view of the auto-focus procedure (Display AF).
= ﬂgg = % ,;T._ - ~ - a .
- - . L 1 g . F >

05X 25,2643 (218,2030) RGB-Overlay ' I 5 -

The drop-down menu below the large image display allows selecting NONE, single channel or a RGB-
Overlay (+ transmission) to be displayed in the main panel.

When RGB-Overlay is selected, the drop-down menus in the colored boxes become available. The
color channels to be displayed in red, green, blue and gray can be selected here. A transmission
channel can be selected in the gray drop-down list.
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The clipping set for the single image channels will be used for the RGB-Overlay. Note however, that the
colors may differ from the single image channels depending on the colors selected there (cf. Chapter
3.2, Display Context Menu).

When RGB-Overlay is selected in the main image, the image status bar lists the zoom-factor, the
intensities in each color channel as 8-bit value and the X/Y pixel-value of the current mouse pointer
position.

When a single color channel is selected in the main image, the image status bar lists the image size, the
zoom-factor, the intensity as 12- or 16-bit value and the X/Y pixel-value of the current mouse pointer
position.

= N~

0.5X 6 (270,2040)

Color channels. Select the color channels from the shortlist underneath each display.

m Zoom tool

Zoom. Activate the tool and click on a display to zoom into the image by a factor of 2 centering on the
click position (if possible) while a Shift click will zoom out.

n Hand tool

Hand tool. Clicking this button in case of a zoomed-in display enables you to move the visible area of
the live image via mouse drag.

Image Display Status Bar. The status bar below each display lists the image size, the zoom-factor, and
the intensity minimum and maximum.

Display AF. Check this box in order to display the images of the autofocus process in the bottom image
display on the right side. If also an image channel is selected in the drop-down menu the display
switches between the autofocus display and the selected image channel. (Note that there may be two
different display settings set for the autofocus and the image display, see Chapter 3.2, Display Context
Menu.) During the autofocus process the autofocus type, Coarse / Fine AF and the autofocus quality is
shown in red in the upper left of the autofocus image.

System Status Bar. The status bar at the bottom of the main window indicates the progress of the scan
and gives an estimate for the remaining scan time. It gives also the actual well number, the total number
of wells to be scanned, the current position, the total number of positions to be scanned, the current
time-loop and the total number of time-loops to be performed, as well as the current plate number in
case multiple plates are scanned using the automatic plate loader. The MT20-icon indicates if the burner
of the MT20 is switched on or off (or if the system is equipped with LED light source).
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3.2 Display Context Menu

Grayscale

Binary
Gradient
Rainbow
Temperature
User Defined

A right-click on a display opens a context menu that allows to select additional display settings and to
configure the multicolor representation.

Palette. Use this command to select the display mode for single channel displays.

Display Settings. Use this command to setup the color display mode. It opens the Display Settings
dialog.

a Display Settings 4

Sealing color

(Click to choose a color)

Intensity clipping: 0% w

Cancel Ok

Display Settings: Scaling color. Click on the Scaling color box to open a new window that allows you
to choose a new image display color (Note that this color is not used for the RGB-overlay).

Display Settings: Intensity clipping. To make automatic scaling more effective when noise or bright
impurities are present, you can define how many pixels (as a percentage of the total number of pixels)
will be displayed uniformly with maximum or minimum brightness. The intensity of the remaining range
of pixels will then be scaled linearly according to the selected color palette. Percentage values can be
set between 0% and 5%. 1% is usually a good value to start with — a slight increase in contrast and
brightness results. If the value is set too high, the dynamic range is reduced visibly and the image may
look oversaturated. Note, that if you use %-clipping, the intensities of different images will be scaled
separately such that you might not be able to visually compare the intensities. In order to get equally
scaled intensities for all images use the histogram clipping.
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Display Settings: Intensity clipping / Histogram

@ Display Settings

Sealing celor

(Click to chooze a color)

Intensity clipping:  Histogram

Cancel

y3 v 20432048 0.17X 95 (467,545)

OLYMPUS

The histogram on the right side of the image displays shows the intensity distribution — in the main
display only in case of single channel displays. If the option Histogram is selected in Intensity clipping,
green horizontal lines that signify the clipping limits can be mouse-dragged to adjust the maximum and
minimum intensity clipping and thus to optimize the image contrast. Note, that the display values are
adjusted for the channels. This means that if you change the channels, the display settings are changed

according to the settings last time the channel was used.
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3.3 Buttons

Scan Buttons. A click on the Start button starts the scan experiment using the current settings. The
Pause and Stop buttons will become active once a scan is started.

Settings Buttons. The Edit and Open buttons lead to the interfaces needed for the setup of system
parameters for a scan experiment.

Open. Allows opening an existing experiment settings file. By default the most recently used settings are
loaded at startup.®

Settings Online observation

Browse Images

Settings

Edit. Allows modifying all the settings necessary for setting up a scan like autofocus, acquisition settings
and plate types (see Chapter 4, Setting up a Scan).

Live. Can be used as a preview window and for changing defined color channels. See Chapter 3.4,
Microscope Control and Live View.

Online observation Buttons. The Browse Images function enables you to browse through the already
acquired images of the current (or a previous) scan. It also allows you to delete entire color channel sets
of images that shall not be considered in the analysis and to generate movies from time loop scans.

The Settings Autofocus function allows adjusting the autofocus settings during a running scan if
necessary.

! scan® is designed for multi-user environments and builds on the Microsoft Windows™ user management infrastructure.
This means that when multiple (Windows-) users start the system, for each user scan” will load each user's default settings.
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3.4 Microscope control and Live View

The Live button opens the Live View dialog that starts live image acquisition and allows to access a
selection of hardware settings directly. The device view can be used as a preview to get an impression
of the sample and to change defined color channels.

B Live View

Zfocus XY navigation
Exposure time [ms]
100 |- |+ |Auto

s Binning

Step size
300 fum] Filter cube

DA/FITC/CY3/CYS -

Objective

Current position UPLSAPO20x

611384 | [um]

Defined Color Channels
DAPI*

lllumination LED excitation
Fluorescence  wr % w -

Clipping
0%
20482048 0.25X 6 (0,0
Focus Ocular view

Live View Plate Type

3.4.1 Microscope Settings

Camera: Exposure time [ms]. The exposure time determines the period of time during which the CCD
chip is sensitive to incoming light, in other words, during which photons are collected and converted into
charges to be read out afterwards. Enter a value manually or use the Auto set button.

Auto set. Use the Auto set button to obtain a value for the exposure time. The exposure time is set
such that the mean intensity of the objects equals a certain value. When the original image was
saturated it may be necessary to press the button several times in order to set the exposure time
properly. (Note that when using the Auto set button in order to set the exposure time for different
assays, the value set for the intensity threshold object detection algorithm of the scan® Analysis software
will be the same for these assays).

Camera: Binning. The camera sensor chip is composed of many light-sensitive units (pixels). These
pixels can be read out individually (binning = 1x1) or the signal of neighboring pixels can be combined
electronically during data readout (binning > 1x1). Binning reduces the spatial resolution but increases
the sensitivity and thus reduces the exposure time required for a good signal-to-noise ratio. It further
reduces the amount of data and consequently increases the readout speed. Therefore binning is
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recommended if weak signals have to be detected at high acquisition rates or if spatial resolution is of
minor importance.

Microscope: Filter cube. Select the filter cube to be used. Note that a filter cube switch is time-
consuming. Imaging speed can be increased considerably by using multi-band filter sets instead of
several single-band sets.

Microscope: Objective. Select the objective to be used. Note that a switch of objectives during an
experiment is possible but rather time-consuming. In order to maintain the same focus position for
different objectives use the Objective Parfocality setup (see Chapter 8.3, Objective Parfocality).

Defined Color Channels. Select predefined color channels. The objective, filter cube, illumination
pathway, excitation filter/ contrast inset and intensity of the illumination are set according to the settings
of the predefined color channel. You can change the settings individually. This is indicated by a “*
behind the name of the color channel. Click on save to store the new settings.

lllumination: Fluorescence / Transmission. Select one of the two possible illumination modes: epi-
fluorescence illumination with the MT20 or transmission illumination.

lllumination: Excitation filter / LED excitation / Contrast insert. Select a MT20 excitation filter or LED
excitation channel for a Fluorescence image or a transmission condenser contrast insert for a
Transmission image, respectively. It has to match with the Microscope: Filter cube selection.

Illumination: Light intensity. Use the slider to set the illumination intensity.
Focus. Performs an autofocus procedure according to the current settings.

Ocular view. Enables the eyepiece. As long as the eyepiece is enabled, the image is not updated and
Ocular view enabled is shown in the upper left of the image. Click again to disable the eyepiece.

Image display when ocular view is enabled.

Live View Plate Type. Allow to select other plates than defined in the current experiment. This is
intended for quick review of different plate types. The selected plate will not influence the experiment
definition but will be used only within the Live View.

19
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3.4.2 Zfocus

Zfocus XY navigation

Step size
300 | [um]

Current position
6113.84 | [um]

OLYMPUS

Z focus

In live views the Z position of the plate is indicated by a blue bar (provided that the stage and the plate

are properly calibrated).

Z focus: Slider. Use the slider for larger movements of the microscope Z-drive.

Z focus: Coarse buttons. Click on the arrows on the left to move the Z-drive in steps 10 times as large

as set in Step size.

Z focus: Fine buttons. Click on the arrows on the right to move the Z-drive in steps as set in Step size.

Z focus: Z-drive steps [um]. Set here the step size for the Z-drive when using the Z-drive buttons.

3.4.3 XY navigation

Zfocus XY navigation

Calumn
1
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Row, Column. Use these boxes to move the stage to the well of interest. Make sure that the correct well
plate type is selected and that the stage is calibrated. See Chapter 8.2, Stage Calibration.

Navigation: Interactive Scheme. The blue circle represents the well currently placed under the
objective. The white rectangle represents the field of view of the camera. Click anywhere in the scheme
and the stage will move this spot to the center of the field of view. When XYZ Limits (cf. Chapter 9.2.2,
LimitSetup.exe) is activated, white lines represent the limits of navigation for X and Y.

3.5 Menus

File » Open. This command loads scan settings from experiment_descriptor.xml files. It can also be
executed with the Open button.

File » Save as. This command saves the current scan settings to an experiment_descriptor.xml file.
Note that this is performed automatically upon starting the scan.

File » Edit. This command allows to edit the current scan settings and to define new types of formats
(see Chapter 4, Setting up a Scan). It can also be executed with the Edit button.

File » Exit: This command shuts down the scan® software.

View » Status Bar: This command minimizes the scan® window to display only the Status Bar.

View » Main Window: This command minimizes the scan® window to display only the largest of the four
displays.

View » Maximized: This command causes the entire scan® window to be shown.

View » Log File. This command opens the Log Viewer. The Log Viewer shows all executed steps of the
scan” system which are relevant to review the current screen. Deactivate the Autoscroll checkbox in
order to navigate through all steps. The Summary view shows on a glance if there were any warnings or

errors during the screen. The By Component view is mainly used by Olympus service to diagnose
potential hardware issues.

EZ Log Viewer

leg  Summary By Companent

Well D000T Pesition D000,
Fine AF...
Acquiring Image
Acquiring Image
Acquiring Image
Well 00001 Positicn O Time 00000 (A1)
Fine AF...
Acquiring Image
Acquiring Image

Acquiring Image .

Details Cempenent
Autoscrell

Advice

Clear Create Support Package Close

Operate » Live View. This command starts live image acquisition and opens the Device Control
window that allows to access a selection of hardware settings directly. It can also be executed with the
Live button.

21
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Operate » Batch Scan. This command opens the Batch Selection window to create a list of experiment
descriptor .xml files and then start a series of scans with different settings.

@ Batch Scan —_

Batch List
D:\Screens\cellCount.xml
D:\Screens\cellCyclexml
D:\Screens\Mitosis!l xml

Operate » Plate Loader Batch Scan. This command opens the Plate Loader Batch Scan window
which allows defining and executing an automated screen of multiple well plates using the automatic
plate loader (See Section 6.6, Multi-level ).

Operate » Multi-level Scan. This command opens the Multi-level Scan wizard which allows defining
and executing an advanced screen with the aim to automatically re-screen a sample based on the
results of a first screen. (See Chapter 7, Multi-level ).

Operate » Start. This command starts a scan. It can also be executed with the Start button.

System » Initialize Devices. This command performs a hardware component check. It is necessary, for
example, if a device is switched on after the software has been started.

System » System Configuration. This command opens the window that allows configuring the hard-
ware modules. (See Chapter 8, System Configuration).

System » Import Plate Types. This command allows importing new plate type definitions that are not
available in the plate type list.

System » Calibrations » Stage Calibration. This command starts the stage calibration (See Chapter
8.2, Stage Calibration).

System » Calibrations » Shading Correction. This command opens the Shading Correction Image
Manager. It is the central location to review, manager, and acquire correction images for the shading
correction (See Chapter 8.5, Shading Correction)

System » Calibrations » Objective Parfocality. This command allows you to set an offset for the Z-
position for the used objectives, so that when changing the objective, the focus is maintained. Therefore
enter a value for Parfocality [pum] to correct the focus shift for the objectives relative to the objective
which you used for the autofocus (See Chapter 8.3, Objective Parfocality).

System » Calibrations » HW-AF Parfocality. This command allows you to calibrate the ZDC hardware
device such that its measurements become independent of the selected objective lens.

About. This command gives system and software information. A support package can be generated
which helps the Olympus service in trouble-shooting in case of any issues.
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4 Setting up a Scan

Chapter 4 — Setting up a Scan

This chapter gives a detailed description on how to customize scan settings and how to setup the

system for maximum performance and reliability. The necessary settings encompass the selection of
appropriate microscope, illumination and camera settings, the autofocus setup, the parameterization of
the well plates and the details of the imaging to be performed at each position.

4.1 Plate Manager......cccccceeeeviiiviieieeeeesiirieeeens
4.1.1 Well pattern......ccccveeeeeeeeniiiiieiee e
4.1.2 PoOSItion patterns ......cccccoevvvveeieeeennniiiieeeennn
4.2  Autofocus SettingsS..........ccccvvveieeeeeeiiiininnenn.
4.2.1 Coarse autofOCUS.......cccevvcvvriiieeeeeesiiiiiieeenn.
4.2.2 Fine autofOCUS ........oeveviiieiiiiee e
4.2.3 Gradient Autofocus Adjustment: Step-by-step

4.2.4 Object-based autofocus: step-by-step

4.3 Acquisition Settings .........cccccvvvveeeeeeiiiiieeenn.
4.3.1 Zstack SettingsS .......cceevvviiiiiieiieeiiiiiiiieeenn,
4.3.2 Time-lapse settingS........ccccvvvvieeeiiniiiiiiennnn,
4.3.3 Other scan settings.........ccccvvvveeeeeeiiiinienennn.
4.4 Live SEttiNGS ...
4.5  Continuous Hardware Autofocus.................
4.6  Confocal Scanning .........occvvveveeeeeinniiinieennn.
4.7  Dual camera acquisition.............cccceevvveennnn.
4.7.1 Acquisition Settings .........cccccvvveeeeeeniiciininnenn.

4.7.2 Parallel acquisition ..........ccccvvvveeeeiiniiiiiieeenn.
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The scan® Screening Station is a complex system with a number of hardware devices and a wide range
of experimental possibilities. In order to perform a scanning experiment, a complete set of parameters is
required with information that allows the controller to synchronize the motorized microscope modules,
the illumination source and the motorized stage with the camera, that configures the autofocusing
procedure and, last not least, defines the type of imaging experiment to be executed at a precise pattern
of positions on the plates and within the wells.

The Edit Scan dialog window allows you to modify and verify all settings. To open it, click the Edit
button or select File » Edit.

B Edit Scan

Plate Manager  SW-Autofocus  Acquisition

All modifications in the settings persist until they are changed again. When starting a scan, the complete
settings will be stored in the resulting data directory in a file named experiment_descriptor.xml. Note that
by default the current user settings are stored when the scanR software is exited and these setting will
be restored on next startup. This means that when multiple (Windows-) users start the system, for each
user scan” will load their default settings.

The current user settings can be stored at any time via File » Save as (or a click on the Save button).
User settings can be loaded via File » Open (or a click on the Open button) from the manually saved
files or from any previous experiment by loading the experiment_descriptor.xml file saved with the
experiment.

The Edit Scan dialog window groups the settings on three tabs:

e Plate Manager to choose the well plate format, and select the wells and the positions within wells to
be imaged.

e SW-Autofocus to define and optimize the autofocus procedure

e Acquisition to define and visually control the microscope, camera and illumination settings, to set
cycle times for scan repetitions and to setup the acquisition of z-stacks

4.1 Plate Manager

The Edit Scan » Plate Manager tab provides the functions needed to define the pattern of wells and the
pattern of positions within each well to be imaged during the scan.

25
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EX Edit Scan X

Plate Manager  SW-Autofocus  Acquisition

Positions in well

Del key removes ~
selected positions Om

Spacing

Left click to toggle wells on/off
Mouse-drag (+ Ctrl) to select (deselect) wells Row spacing [Lum]

EMeander wells Wells selected 60 3
Full in

Well diameter [um 6497
[ centinuous zne [pm] 6497

Acquisition order

Plate
CellCycle Hela Edit selection table Center

Type

96w Edit plate types Show order

Calibration status: A1 position calibrated

can will result in 6000 images acquired. Cancel

4.1.1 Well pattern

The circles (or squares) in the scheme represent the wells of the selected well plate type. Blue circles
are wells activated for scanning, gray circles are wells to be skipped. When changing the set plate in the
Type drop down menu, all wells will be automatically selected. In order to exclude wells from being
imaged, deselect these by clicking on individual wells or press the Ctrl-key and drag a region around the
wells to be deselected.

Plate. Enter a name in the text field. If the plate name is unchanged in the course of consecutive scans,
the scan directories will be stored with an incremented numeration appended to the given name.

Type. Select the well plate format from the shortlist of standard plate types. It is possible to add custom
plate types via Edit plate types and the Plate Type Settings window; see Section 5, Well Plate Library.

Edit selection table. This opens the Well Description window with the list of selected wells. You can
enter a name or description for the selected wells. It is also possible to Import a well selection.
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Wells selected. Shows the number of currently selected wells. All wells are selected by default. Click on
a well to deselect it. Click again to select it. To select a group of wells, drag a rectangle around the wells.
To deselect a group of wells, press the Ctrl key and drag a rectangle around the wells.

Meander Wells. Check this option if the wells are supposed to be scanned in meandering order rather
than in numeric order (row by row from left to right).

Continuous hardware autofocus. Activates a special autofocus mode which will only be available
under certain conditions. It is prerequisite the system is equipped with the IX3-ZDC2 revision of the
hardware autofocus device. See Section 4.5 Continuous Hardware Autofocus for further details.

4.1.2 Position patterns

scan” is able to scan a series of positions within each well. The pattern of positions to be scanned is
defined in the Positions in well box on the right side of the Plate Manager. To specify the pattern to be
scanned within each well, use the Positions, Spacing and Selection fields. The pattern is based on a
basic rectangular pattern and can then be refined by manual selection of a sub-set of positions. The
position that will be scanned first is highlighted blue. In order to show a simulation of the order in which
the positions are scanned click on show order.

The number of Columns and Rows as well as their distances can directly be entered in the
corresponding fields. Alternatively a special Pattern can be selected from the shortlist. By default the
spacing between adjacent positions is set so that neither an image overlap nor a gap results. It is
calculated from objective magnification and camera chip size.

Pattern. Set the number of Columns or Rows that are to be scanned within one well. The dropdown
box contains also special patterns like single, 2*2, full in and full out.

Del key removes
selected positions

Full in Pattern

Spacing: Column spacing [um]. Set here the distance between (the centers) of two adjacent Columns
of positions.

Spacing: Row spacing [pm]. Set here the distance between (the centers) of two adjacent Rows of
positions.

Spacing: (Tile). Click here to reset the spacing between columns and rows to the default
(without gaps or image overlap).
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Tile

Spacing: (Spread). A click on this button will distribute the positions in equal distances within the
whole well. To reset the pattern to adjacent positions, click on Tile.

Positions in well

Del key removes
selected positions O=

Field of view. This is the specimen area covered by a single image. It depends on objective
magnification and camera chip size.

Total positions. Shows the number of positions per well.

The scheme shows the basic rectangular positions pattern relative to the entire well (the green circle).
By default all positions will be scanned. To modify this pattern use the tool buttons on the left to select
a sub-set of positions. Remove the selected positions from the well pattern by pressing the Del key.
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Positions in well

Del key removes
selected positions

Full in pattern with removed central positions.
Selection: (Invert). Click here to invert the pattern of selected positions.

Selection: (Reset position defaults). Click here to return to the basic positions pattern (as
defined by Columns/Well and Rows/Well) and the default autofocus settings for each position (see the
Selection context menu).

Selection: (Fill). Click here to fill a ROI (e.g. a drawn circle or rectangle) with sub-positions.

Selection context menu. A right-click on a position opens its context menu. This context menu allows
selecting the kind of autofocus to be carried out at every position individually. Depending on the sample
it may or may not be useful to carry out the hardware autofocus and/or the coarse software autofocus
only at the first position and only the fine software autofocus at each position.

'‘AF Coarse

AF Hardware

Acquisition order: Meander. Click here if the positions are to be scanned in meandering order rather
than in numeric order (row by row from left to right).

Acquisition order: Center. For arbitrary patterns the position next to the center is selected as starting
position. Subsequently adjacent positions are scanned.

Acquisition order: Unidirectional. Click here if the positions are to be scanned in numeric order (row
by row from left to right).

29
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Positions in well Positions in well

Del key removes -~ 0 Del key removes ~
selected positions Om selected positions Om

Pattern Spacing Pattern Spacing

Columns Column spacing [um] Columns Column spacing [um]

Row spacing [um] Row spacing [um]

Specific W Specfic  w

Acquisition order Acquisition order

Field of view [um x pm] Field of view [um x pm]
Meander - { 666 . 666

Total positions

Show order & Show order

Meander Center start

Acquisition order: Show order. Click here to display an animation of the optimized position acquisition
order. Click again to stop the animation.
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4.2 Autofocus settings

EX Edit Scan

Plate Manager  SW-Autofocus Acquisition

Test system settings

Layers
Gradient

Step width 3.20

Scan range [pm]
100 12
80

60
Camera

Exposure time [ms! Binning
30 - |+ Auto 4 -
Current position
Microscope

Objective Filter cube
UPLSAPO 20x W DASFITC/Cy3/Cys W

Fluorescence

LED excitation
w

Intensity

Scan Set tus

Info: This scan will result in 6000 images acquired.
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Layers.

Step width 0.80

Scan range [pm]

2.1

Coarse focus position

Dﬂreakwhen peak found

Auto settings

Calculated depth of field

800 T Set as step width

Cancel

Test system settings. Click here to open the Autofocus Settings window. It allows you to focus
manually and to control if the autofocus channel settings lead to images suitable for autofocusing.

the settings (e.g. exposure time).

When opening the Autofocus settings window, the SW-Autofocus tab remains active.
Move the Autofocus settings windows aside to access the SW-Autofocus tab and change

Type. Select the method to quantify the image focus from the following options:

e Gradient. The focus is determined by analyzing mean intensities and intensity gradients of image

structures.

e Object-based. The software first detects the objects in each image and then determines the focus by
analyzing their mean intensities and intensity gradients. The result is weighted with the number of
detected objects. The objects have to be defined in the Autofocus Settings window, which can be
accessed through the Test system settings button. See Chapter 4.2.5, Object-based Autofocus).
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@ Note that image acquisition is skipped if no objects are detected to save disk space.

e Object-based: coarse on Al. This is the same method as above with the difference that only on the
first position of the first well both a coarse and a fine autofocus scan are carried out. On all other
positions only the fine autofocus is performed. This leads to an increased imaging speed, however is
only suitable for plane samples.

e Object-based coarse, gradient fine. This method combines the other methods to determine the
focus. The object-based focus quantification is used for the coarse autofocus, while the gradient-
based quantification is used for the fine autofocus.

@ For ease of use it is recommended to select the Gradient mode if possible.

Timelapse settings. Click here to define the autofocus settings for time lapse acquisitions. If Repeat
autofocus in each time-lapse cycle is activated, autofocus scans will be repeated in each time-lapse
cycle. This reduces the overall speed of the experiment considerably but may be necessary if focus
drifts are to be expected. Alternatively, Repeat only fine autofocus with n layers can be selected or,
using Do not repeat autofocus, the autofocus procedure can be restricted to the first time lapse cycle.

Camera, Microscope and Illlumination settings. (See Chapter 3.4, Microscope Control and Live View)

Exposure time: auto set. Use the auto set button to obtain a value for the exposure time. The auto set
button is available only when the Autofocus settings window is opened via the Test system settings
button. The exposure time is set such that the mean intensity of the objects equals a certain predefined
value. Note that this value may be much lower than the value specified for the image acquisition
channels (see Chapter 3.4.1, Microscope Settings and Chapter 4.3, Acquisition Settings) to reduce the
time necessary for the autofocus procedure. When the original image was saturated it may be necessary
to press the button several times in order to set the exposure time properly.

The SW-Autofocus tab will be disabled completely when the continuous hardware autofocus (cf.
Section 4.5 Continuous Hardware Autofocus) is enabled.

4.2.1 Coarse autofocus

The following settings are interdependent and the software will adjust the controls using the equation
Scan range = Layers x Step width.

Scan range [pm]. Use one of the sliders or type in a value to set the search range for the coarse
autofocus. Make sure that the range is large enough to encompass all possible variations of focal
positions caused by the unevenness of the substrates.

@ If the scan range is set too large, it may be possible that the autofocus focuses on the wrong
surface, for example on dust particles underneath the plate.

Step width [um]. The step width between neighboring Z-positions is set automatically to four times the
Calculated depth of field (see next Chapter 4.2.2, Fine Autofocus). However, it can be changed at will
here.
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Layers. This is the number of layers to be imaged during the coarse autofocus scan. It is automatically
calculated from Step width and Scan range.

Interpolate AF start positions. This function is deprecated and probably will be removed in future
versions of the scan® software.

Collect reference positions. This function is deprecated and probably will be removed in future
versions of the scan” software

4.2.2 Fine autofocus

Calculated depth of field. This is the theoretical depth of field as determined by the NA of the selected
objective. It is not necessary to set the step width significantly smaller than this value. An approximation
(450/NA? nm) is used for the calculation of the depth of field.

Set as step width. Click here to set the Calculated depth of field as step width between neighboring
Z-positions of the fine autofocus scan. The number of Layers will be adjusted automatically.

@ This function additionally sets the step width of the Coarse autofocus to four times the
Calculated depth of field and adjusts the number of Layers accordingly.

The following settings are interdependent and the software will adjust the controls using the equation
Scan range = Layers x Step width.

Scan range [um]. Use one of the sliders or type in a number to set the imaging range for the fine
autofocus. Reasonable values to start are +10 um and -10 pm.

Step width [um]. You may set here a value different from the Calculated depth of field as step width
to be made between neighboring Z-positions during the fine autofocus scan.

Layers. This is the number of layers to be imaged during the fine autofocus scan. It is automatically
calculated from Scan range and Step width.

Break when peak found. When setting this option, the focus search finishes n layers (Layers after
peak) after a possible focus position has been found. This behavior is particularly useful for transmission
images to increase accuracy of the focus search

4.2.3 Gradient Autofocus Adjustment: Step-by-step

The Gradient Autofocus algorithm determines the focus by analyzing local intensity gradients of
image structures.

1. Select the Gradient autofocus procedure.

2. Select suitable Camera, Microscope and lllumination settings.
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Click the Fine autofocus: Set as step width button to automatically set the Fine autofocus:
Layer and Step width Step width.

Set the Fine autofocus: Scan range to +/-10 um, for example.

Set the Coarse autofocus: Step width to 10 pum. It should not be larger than half the Fine
autofocus: Scan range.

Set the Coarse autofocus: Scan range to +/-50 um, for example.

Once finished, click the Test system settings button.

The Autofocus settings live image window will open and display a live image acquired with
the settings of the SW-Autofocus tab...

Focus manually using the Z-focus wheel on the microscope or use the Z-focus tools (see
Chapter 3.4.2, Z Focus) in the software to focus the sample roughly. You can use Ocular
View to switch the microscope from camera view to ocular view when using the Z-focus wheel
on the microscope to set the focus.

EZ Autofocus settings

Coarse -

=

Step size
300 [um]

Current position
612245 | [um]

Fine Z-layers fine

o 45785
0% cipping

- - o P ' 4 it
L‘ - 8 W 213
y Y - "
- = & “ q O/
.

Clipping
0%

& O
Autofocus quality

5125121%6 (224,31 E

Ocular view = Coarse  Z-layers coarse

10. In order to change the illumination or microscope settings, you can move the Autofocus

settings window aside to have access to the Edit scan » SW-Autofocus tab. The changes
made in the SW-Autofocus tab will immediately be applied.

11. Click Focus to run the autofocus. First the coarse AF is performed and afterwards the fine

AF. Afterwards the focused image is displayed in the main panel and on the graph on the right
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the quality of the AF procedure is displayed. The focusing was successful when both curves
(for fine and coarse AF) show a pronounced peak.

12. To optimize coarse and fine range change the corresponding settings in the SW-Autofocus
tab and click again Focus in the Autofocus settings window to run the AF procedure. (You
can also navigate to other positions on the plate using the XY navigation tool, (see Chapter
3.4.3, XY Navigation)

13. When you are satisfied with the result close the Autofocus settings window by clicking OK.

4.2.4 Object-based autofocus: step-by-step

The Object-based Autofocus algorithm first detects the objects in each image and then determines the
focus by analyzing their local intensity gradients.

The weighting function of the coarse autofocus is calculated from the sum of all objects' sharpness
functions and is very sensitive to the number of objects detected. The Object-based Autofocus
properties must be adjusted carefully to ensure that the number of objects is maximal when the image is
focused.

The Object based autofocus may be suitable if a certain structure placed in a certain Z-layer within the
sample is to be focused (e.g. small cells growing upon larger cells). By setting min / max cell size
accordingly, it can be ensured that the desired objects are used for autofocus.

o Note that the Object-based Autofocus properties are important also because images free
of detected objects will not be stored on hard disk during the scan.

Click the Test system settings button on the Edit Scan » SW-Autofocus tab to open the Autofocus
Settings window. The functions needed to adjust the object recognition are shown in the Autofocus
Settings window.

Threshold. The threshold causes all image areas — better said all image pixels — of lower intensity to be
ignored for object detection. This prevents that background noise or low-intensity artifacts are falsely
detected as objects. The value should be somewhat higher than the background intensity but lower than
that of any cell or structure of interest.

Minimum size. Activate this option if you want to set a minimal size for detected objects. Enter the
minimal number of pixels in the box below.

Maximum size. Activate this option if you want to set a maximal size for detected objects. Enter the
maximal number of pixels in the box below.
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E Autofocus settings

Zfocus XY navigation

Step size
EX T

Current position
611645 | [um]

Z-layers fine
4
—
o 683
0% chipping

Clipping
0%
5123121X 16 (274,4) [i]

Ocular view — Coarse  Z-layers coarse

Threshold | Frereis W] Maximum size [m] Mark center
Ii‘ Frame objects

Objects found: 138 50 500 [pixels] [W] ignere border objects

I:‘ Maximum object intensity
lue]

Set current ROl Set current ROl

It is possible to use regions of interest (ROIs) to set the maximum and minimum size. To do so, click the
ROI button (rectangle icon next to the bottom right corner of the live image) and draw a (green)
rectangle to define the respective ROI. Click Set current ROI to adopt the values of the ROI.

Minimum cell size: Set current ROI. Click here if you have defined a ROI that determines the minimal
size of the objects.

Maximum cell size: Set current ROI. Click here if you have defined a ROI that determines the maximal
size of the objects.

Mark center. Activate this option in order to mark the center of each detected object with a red dot.
Frame object. Activate this option in order to mark each detected object with a red bounding frame.
Ignore border objects. Activate this option in order to have objects touching the image borders ignored.

Maximum object intensity. Activate this option to have objects ignored which exceed the provided gray
value

1. Select the Object-based autofocus procedure.

2. Select suitable Camera, Microscope and lllumination settings.

3. Click the Test button on the Edit Scan » SW-Autofocus tab to open the Autofocus
Settings window
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Focus manually using the Z-focus wheel on the microscope or use the Z-focus tools (see
Chapter 3.4.2, Z Focus) in the software to focus the sample. (You can use Ocular View to
switch the microscope from camera view to ocular view).

Set a value for Threshold. To determine a meaningful value, activate the pointer tool by
clicking the arrow button in the tool bar at the bottom right side of the image window. Move
the cursor over a background area towards the border of an object. The image information bar
below the image window list the intensity at that point. For an initial try you may set the
threshold to such a borderline value.

Activate Minimum cell size and click the ROI and draw a rectangle which is somewhat
smaller than the smallest object to be detected.

Click the Set current ROI below Minimum cell size. The value is entered in the
corresponding pixel field. Alternatively you can directly enter a value in the pixel field.

Activate Maximum cell size and click the ROI and draw a rectangle which is somewhat larger
than the largest object to be detected.

Click Set current ROI below Maximum cell size. The value is entered in the corresponding
pixel field. Alternatively you can directly enter a value in the pixel field.

10.

Check Mark center and Frame object.

11.

Click Focus to run the autofocus. First the coarse AF is performed and afterwards the fine
AF. Afterwards the focused image is displayed in the main panel and on the graph on the right
the quality of the AF procedure is displayed.

12.

The detected objects are indicated by a red box.

4.3 Acquisition settings

Selected Color Channels list. This lists all currently defined color channels in the order of acquisition.
Select a channel by mouse click for modification. Drag a channel up or down to alter the channel
acquisition order.

New. Click here to add a new color channel to the list. The new channel will be given the name Blank by
default and can be changed in the Name box. It will be used for the image file name upon storage.

Remove.

Removes a channel from the selected color channels. The channel will be stored in the

Defined Color Channels list.

Defined Color Channels List of predefined color channels. The predefined color channels can be
changed in the Device window (Settings » Devices).
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Add to list. Adds a selected color channel from the Defined Color Channels to the Selected Color
Channels. The color channel will be added at the bottom of the list.

Delete. Click here to delete the listed Image type from the Defined Color Channels list.

Live settings. Click here to start a live image acquisition in a new window that opens. This allows
observing the influence of the settings changes online. See Chapter 4.4, Live Settings. Note that first an
autofocus scan will be carried out. When no ZDC is available, a starting position has to be selected for
the autofocus procedure. After that an autofocus is performed and the Live settings control window
opens.

EZ Edit Scan

Plate Manager ~ SW-Autofocus  Acquisition

Selected Color Channels
Name
DAPI
Cy3
FATC
Trans

Channel Settings

Name
DAPI
Fluorescence

Live settings

LED excitation

uv
Microscope Camera

Remove

Defined Color Channels

Objective
UPLSAPQ 20x w

Filter cube
DA/FITC/Cy3/CY5 w

Focus offset [um]

5 Intensity 100
Exposure time [ms]

100 = | +| Auto

Preacquisition delay
0 S B =]

Frame averaging

DAPI 0.00 = |- 1 = |-

Add to list Delete

Camera binning
1x1 -

Storage directory
D:\Data\Screens

Cancel

Info: This scan will result in 6000 images acquired.

Microscope: Objective. Select the objective to be used. Note that a switch of objectives during an
experiment is possible but rather time consuming. In order to maintain the same focus position for
different objectives use the Objective Parfocality setup (see Chapter 8.3, Objective Parfocality). If the
Global objective change option is activated in the System Configuration (see Section 8.1.2,
Microscope), the objective will be kept synchronized between all Color Channels and the autofocus
settings.

Microscope: Filter cube. Select the filter cube to be used. Imaging speed can be increased
considerably by using multi-band filter sets.

Microscope: Z offset [um]. This allows setting a Z-position offset for the image acquisition relative to
the position found by the autofocus. The offset is useful for imaging structures that are located in a
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different Z-position within the sample than the position found by the autofocus. The Z-offset is most
conveniently set interactively in the Live Settings window (see Section 4.4, Live Settings).

Shading Correction: Apply for acquisition. This option can be activated if the necessary correction
images for the selected color channel and the current objective are available (see Chapter 8.5, Shading
Correction). Activating this option will apply the shading correction to the acquired images before they
are saved to the disk. Independent of this option, all available and relevant correction images will always
be stored with the acquired data.

Camera: Exposure time [ms]. The exposure time determines the period of time during which the
camera sensor chip is sensitive to incoming light, in other words, during which photons are collected and
converted into charges to be read out afterwards. Enter a value manually or use the Auto set button.
The type of camera attached to the system will be automatically detected. For the Hamamatsu EM-CCD
camera the camera control box contains also a field to set the EM Gain. Set 0 for no gain and 255 for
max gain.

Camera: Auto. Use the Auto button to obtain a value for the exposure time. The Auto set button is
available only when the Live settings control window is opened via the Live Settings button. The
exposure time is set such that the mean intensity of the objects equals a certain value. When the original
image was saturated it may be necessary to press the several times in order to set the exposure time
properly. (Note that when using the Auto set button in order to set the exposure time for different
assays, the value set for the intensity threshold object detection algorithm of the scan® Analysis software
will be the same for these assays).

Camera: Preacquisition delay [s]. You may set a delay to be applied before the color channel is
acquired. Enter a preacquisition delay, e.g. if transmission light intensity is to be changed during
acquisition to wait for the light intensity to reach a constant value.

Camera: Frame Averaging. If the number of frames set here is larger than 1, multiple frames will be
acquired for each position and Color Channel and the images will be averaged to reduce noise. This is
particularly useful for transmission images with high intensity but low contrast. For performance reasons,
the averaging will only be applied during a scan and not in live view.

lllumination: Fluorescence / Transmission / Fluorescence (CSU). Select one of the two possible
wide field illumination modes: epi-fluorescence illumination with the MT20/LED, or transmission
illumination. Optionally, if the system is equipped with the CSU confocal option, a third mode for confocal
imaging can be selected. Special settings for the CSU option are described in Section 4.6, Confocal
Scanning.

lllumination: Excitation filter / Contrast insert / LED excitation. Select a MT20 excitation filter or LED
channel for a Fluorescence image, or a transmission condenser contrast insert for a Transmission
image, respectively. It has to match with the Microscope: Filter cube selection.

lllumination: Light intensity. Use the slider to set the illumination intensity of the MT20, the LED, or the
transmission light, respectively.

Storage Directory. Set here the general scan data directory. The data for each individual plate will be
stored here in a subdirectory with the same name as the plate.
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4.3.1 Z stack settings

|7 stack settings disabled

In the Z stack settings box you can set the number of Layers for the z stack as well as the Step width.
Z-stack settings: Layers. Set the number of layers of the Z-stack.
Z-stack settings: Step width [um]. Set the distance between the layers of the Z-stack.

In the drop down menu First loop you can select the order of image acquisition for the z stack. With the
setting First loop: Z stack, the system will first acquire the whole stack for one color channel and then
repeat the z stack acquisition for the next color channels. With the First loop: Channels setting, the
system first acquires images for all color channels at one z position and then goes to the next z position
until the z stack is complete.

Note that the Z stack settings are grayed as long as 1 layer is set. The other options are grayed out in
order to indicate that no z stack experiment is acquired. As soon as more than 1 Layer is set, the Z
stack settings will be enabled.

First loop
Channels

Step width [um]

-+

Z stack settings enabled

Furthermore, the Selected Color Channels list box will offer additional settings per channel. Using the
context menu of the list box (by right-clicking on a channel), it is now possible to select for each active
channel if a z-stack is acquired, or a projection or only the in-focus image.

Selected Color Channels

Name z

DAPI Stack

Cy3 Stack
FITC Proj.
Trans Single

Z stack settings

Z-stack settings: Projections. If this option is selected for a channel, a Z-stack will be acquired but not
saved as such. The software calculates a maximum intensity projection (*fitc_zMax.tif), a maximum-
minus-mean intensity projection from Z-stack (*fitc_zMaxBkg.tif) and a layer-of-origin image of the
maximum intensity projection (*fitc_zMaxZ.tif) and only keeps the central layer (i.e. the layer found by
the AF procedure) of the original stack (*fitc.tif). All four images are then being stored as a four-channel
image. (Recommended to use with high Numerical Aperture (NA) objectives; use * zMaxBKG.tif for
object segmentation in the Analysis).
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fitc.tif fitc_zMax.tif

fitc_zMaxBKkg.tif fitc_zMaxZ.tif

First loop: Z stack. First all layers of the z stack for the first color channel are acquired, then a z stack
for the next color channel is acquired, and so on. This has the advantage that the time consuming steps
such as filter cube change and excitation filter change are performed only once at the beginning of a z
stack.

First loop: Channels. When this option is selected for every layer of the z stack all selected color
channels are scanned consecutively. Only when all color channels are acquired, the objective moves to
the next z position and then all color channels at this position are acquired, and so on.

4.3.2 Time-lapse settings

Time-lapse settings: Loop. Select the kind of time-lapse experiment: for the whole plate, for a well or
on each single position of a well.

Time-lapse settings: Cycles. Set the number of times the entire plate scan is to be repeated.

Time-lapse settings: Cycle time. Set the repetition time. If this time is smaller than the time required
for a single run, the repetition will be performed as fast as possible without delay.

Note that the time-lapse settings are grayed as long as in the time-lapse control boxes only 1 cycle is
set. The other options will be grayed out in order to indicate that no time-lapse experiment is acquired
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4.3.3 Other scan settings

Camera binning. The camera sensor chip is composed of many light-sensitive units (pixels). These
pixels can be read out individually (binning = 1x1) or the signal of neighboring pixels can be combined
electronically during data readout (binning > 1x1). Binning reduces the spatial resolution but increases
the sensitivity and thus reduces the exposure time required for a good signal-to-noise ratio. It further
reduces the amount of data and consequently increases the readout speed. Therefore binning is
recommended if weak signals have to be detected at high acquisition rates and if spatial resolution is of
minor importance.

Magnification Changer. This option is available for systems equipped with an encoded magnification
changer. The software will take care that the actual magnification changer position is consistent with this
scan setting.

4.4 Live settings

Click the Live settings button in the Edit Scan » Acquisition tab to come to the Live settings control
window that allows you to observe the changes of the settings on the image acquired by the camera.

1. If a ZDC hardware autofocus is available the system will first perform a complete hardware
and software autofocus run as defined in the Edit Scan » SW-Autofocus tab; see Chapter
4.2, Autofocus Settings)

2. When the AF procedure is completed, the Live settings control window opens. The quality
of the autofocus is shown as a graph.

B Live settings control

Zfocus XY navigation

Z-offset (relative to the AF position)

Step size
300 | fum]

Z-offset
000 | fum]

Fine Z-layers fine

200 (B 7 , : 0 1 2
—— g
o e
5 cipping

Clipping
0% -

Autofocus quality

2048204805 40 (1352,876)

0 1 & 4 5 6
Ocular view — Coarse  Z-layers coarse

Cancel
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1. If no ZDC is available and the focus of the active plate type has not been calibrated, the
starting position for the software Autofocus has to be set first. In this case the Manual Focus
window opens. The settings of the SW-Autofocus tab are used for this display (i.e. the color
channel used for autofocus is shown).

EZ Manual focus
The software autofocus requires a starting position.

1. Focus the specimen.
2. Click OK to confirm.

Zfocus XY navigation

Coarse = | Fine

+ g +

Step size
300 |qum)

Current position

80122 | fum)

o
0% cipping
Clipping
0%
S126122X 17 (308,177)
Ocular view

2. Focus manually using the Z-focus wheel on the microscope or use the Z-focus tools (see
Chapter 3.4.2, Z Focus) in the software to focus the sample. (You can use Ocular View to
switch the microscope from camera view to ocular view).

3. Click OK to start the software autofocus.

4. Once the autofocus run is completed the Live Settings control window will open. The quality
of the autofocus is shown as a graph.

When opening the Live settings control window, the Acquisition tab remains active. Move
@ the Acquisition settings windows aside to get access to the Acquisition tab and to
change the settings (e.g. color channels, exposure time, etc.).

You can now change and check the settings in the Edit scan » Acquisition tab and have control over
these settings in the Live settings control window simultaneously. The status bar below the live image
display gives information about the image size, the display zoom factor, the image type as well as the
intensity and the coordinates of the cursor. Check the exposure time for all color channels and avoid
over-saturating the camera by keeping the maximum intensity well below 4,000 or 65,000 counts (for a
12-bit camera or 16-bit camera, respectively). Adjust the Camera: Exposure time on the Edit Scan »
Acquisition tab accordingly.
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E Live settings control

Zfocus XY navigation

Z-offset (relative to the AF position)
: | Fine

-

Step size
3.00 [um]

Z-offset

0.00 [um]

0% dipping

Clipping
0% -

£
B
=1
=
e
s
o
£
£
5
=3

2048x2048 0.5X 40  (1352,876) 0 1 2 3 4 5

Ocular view —Coarse  Z-layers coarse

Cancel

e Depending on the model, the camera can have bit depths of 12 or 16 so that saturation is
reached at pixel values of 4,095 or 65,535, respectively. However, the pictures are alwys
stored with 16 bit depth for reasons of computer efficiency.

Z-offset (relative to the AF position). Use the arrow buttons to determine the focus offset of the
different channels relative to the position found by the autofocus. The offset is useful for imaging
structures that are located in a different Z-position within the sample than the position found by the
autofocus. The Z-offset set in the Live settings control window is also entered in the Z-offset field of
the Edit Scan » Acquisition tab. Color channels are switched by selection on the Edit Scan »
Acquisition tab. (Note that in the Live settings control window you can only change the Z-offset, but
not the Autofocus properties.)

Autofocus quality: Coarse and Fine. These two graphs enable you to judge the performance of the
software autofocus. If either graph shows a pronounced peak, the focus has been found and the settings
in the Edit Scan » Autofocus tab are suitable. If the maximum of one or both curves is located at the
left or right border of the scan range, the settings have to be adjusted.

If the Autofocus quality functions do not show a pronounced peak, the focus has likely not
@ been found. Enlarge the Coarse autofocus: Scan range in the Edit Scan » SW-Autofocus
tab or try to find a more reasonable starting position.
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4.5 Continuous Hardware Autofocus

The continuous mode is a special mode for hardware autofocusing. It is only available if the scan®
system is equipped with the 1X3-ZDC2 hardware revision of the hardware autofocus device. The basic
concept is that the sample always is kept in focus, even when moving from position to position or from
well to well.

While the continuous focusing mode has limitation regarding flexibility, and high demands regarding the
well plate bottom quality, it will be really fast if possible to use. Continuous mode is restricted to scanning
a single z-plane (no combination with inter-channel offsets, z-stacks or software autofocus possible) and
requires a high-quality well plate bottom which has low variations in thickness, depending on the depth-
of-field of the used microscope objective lens.

Left click to toggle wells on/off

Mouse-drag (+ Ctrl) to select (deselect) wells

IE‘Meander wells Wells selected 60

i Well diameter [pum 6407
[m] continuous Znc [pm] 6497

Activate Continuous hardware autofocus in Edit Scan » Plate Manager tab. This will automatically
de-activate all options which cannot be combined with continuous mode, including the complete SW-
Autofocus tab.

In the Positions in well configuration tool, individual positions can be configured to Wait for HW-AF
which will verify actively that the sample is still in focus there. Depending on the plate properties and
settings, the effective focusing time per position can be << 100 ms.

4.6 Confocal scanning

The optional Confocal Scanner Unit (CSU) adds the capability of high-speed confocal imaging to the
scan” screening station. When this option is available, there are additional control elements visible in the
workflow of setting up a scan. In particular, the autofocus settings and the acquisition settings have
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the additional confocal imaging mode Fluorescence (CSU) in addition to the wide field modes

Fluorescence and Transmission.
s Edit Scan

Plate Manager  SW-Autofocus Acquisition

Test system settings Coarse autofocus

Layers
Gradient

Step width

Scan range [pum]
100 12

80

60
Camera #1 W

Exposure time [ms] Binning
200 |0 28 -

Current position
Microscope

Objective
UPLSAPO 20x W

Filter cube
DA/FITC/CY3/CyS w

lllumination
Fluorescence (CSU)
Laser excitation CSU dichroic mirror

561 405/488/561 -
Emission

CSU emission filter 1 CSU camera port

525/50 v DM3561LP w
100 %

Info: This scan will result in 3000 images acquired.

Fine autofocus
Layers

Step width

Coarse focus position

-30

DBreakwhen peak found

Auto settings

Calculated depth of field
Set as step width
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B Edit Scan

Plate Manager ~ SW-Autofocus  Acquisition

Selected Color Channels Channel Settings.

Name

FITC_confocal
Cy3_confocal

Name
Cy3_confocal

Live settings

D Parallel acquisition

Microscope
Objective

UPLSAPO 20x w

Remove
Filter cube

Defined Color Channels Focus offset [pm]
Cy3_confocal 0.00 -+

Add to lis Delete

Scan Settings

Z stack settings Time-lapse settings

Layers i Cycles

Storage directory
DA\Data\Screens

Il result in 3000 images acquired.

Shading Correction

Df\:-p\_ for ac

Camera #1 W

Exposure time [ms]

500 = #| Auto

Preacquisition delay

] s

Frame averaging

1 -+
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lllumination
Fluorescence {(CSU)
Laser excitation CSU dichroic mirror
561 v 405/488/561 w
Intensity

|

Emission

CSU emission filter 1
617/73 w

Camera binning

CSU camera port
DM 561 LP

Cancel

lllumination: Laser excitation. A laser light source is used for confocal imaging. Depending on the
configuration, one or multiple different laser colors can be used for fluorescence excitation.

lllumination: CSU dichroic mirror. The suitable dichroic mirror within the CSU device.

Emission: CSU emission filter 1. The suitable emission filter within the CSU device. In case of the dual
camera option, the CSU emission filter 2 can be selected for camera 2.

Scan Settings: CSU disk. Select a different spinning disk for this scan (optional).

Scan Settings: CSU camera port. Select the camera port splitter (optional; only in combination with

dual camera option).

The optional CSU specific control elements are also visible in Live View when the confocal scanning

option is available for the scan® system.
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4.7 Dual camera acquisition

The dual camera option enables the acquisition of two color channels with best possible speed. The
dual camera option requires the confocal scanning option which includes the necessary image splitting
optics and two independent emission filter wheels for the two cameras.

Exposure fime [ms]

500 =0 BpR Auto

Preacquisition delay

(1] = = [s]

Frame averaging

1 -

When the dual camera option is available, the Camera configuration in the autofocus settings, the
acquisition settings and the Live View enables the selection of the camera (#1 or #2) to be used for
the autofocusing or for the current color channel.

4.7.1 Acquisition settings

Dual camera acquisition can increase the scanning speed significantly if it is used in such a way that two
color channels which are acquired successively fulfil the following requirements:

1. The two successive channels are assigned to the two different cameras. For example, the first
channel uses the camera #1, the second channel uses the camera #2.

2. The two channels share the same imaging mode, for example both channels are Fluorescence
(CSU) channels

3. The two channels are only different in the excitation wavelength and the CSU emission filter

If these prerequisites are fulfilled, the two color channels can be acquired without the need for any
mechanical movement in between.

4.7.2 Parallel acquisition

If the prerequisites for maximum scanning speed (see Section 4.7.1, Acquisition settings) are fulfilled,
two channels can even be acquired at the very same time. In order to enable Parallel acquisition for
two color channels, the option has to be activated for the second channel of a pair.

Parallel acquisition
Dk‘ q
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As a result, the two color channels will be linked and acquired as a pair at the very same time. This will
increase the acquisition speed most because both cameras are exposed simultaneously. On the other
hand, cross-talk (bleed-through) between the two color channels might be increased.

=4t Edit Scan

Plate Manager ~ SW-Autofocus  Acquisition

Selected Color Channels Channel Settings

Name

M Cy3_confocal

| Name Shading Correction lllumination
U ATC_confocal

D-H:\_ for

FITC_confocal
Live settings
E Parallel acquisition

Microscope

UPLE 0 - 1

|
Remove 100 %

Filter
Emission
Defined Color Channels o ff Frame & ing CSU emission filter 2
FITC_confocal - 1 - 525/50 -

Delete

Scan Settings
Z stack settings Time-lapse settings

Layers irs p Cycles

CSU camera port
DM 561 LP

Storage directory
D:\Data\Screens

Setup St

This scan will result in 4800 images acquired. Cancel

Two linked channels are indicated by a connecting symbol in the Selected Color Channels list. For the
second channel of a linked pair, all control elements which cannot be different for a pair of linked
channels are disabled.

A pair of linked channels can be split at any time by unchecking the Parallel acquisition option for the
second channel. This will result in normal, successive (sequential) acquisition with less increased
scanning speed but minimal crosstalk (bleed-through) between the two channels.
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5 Well Plate Library

Chapter 5 — Well Plate Library

scan” features a well plate library which allows easy management of different well plate types. A number
of typical well plates are predefined and can be simply selected when setting a new scan. The software,
however, is very flexible and enables defining even unusual and non-standard well plate and other dish

formats for easy use in various scans.

5.1 Well plate types.......ccceevvvvriieeeeeeiiiiiiieee e
5.1.1 System standard well plates ..............ccceenn.
5.1.2 User calibrated well plates...........ccccvveeeeennns
5.1.3 Non-calibrated well plates...........cccccvvvveeeeennnns
5.2  Plate type settings........ccccvvvveeeeeiiiiiiiieee e
5.3  Defining multi-slide plate holder.....................
5.4  Well Measurement.........ccccocvveernnreeenineeenne
5.4.1 Well measurement: Al center position only
5.4.2 Well measurement: 2/3-point A1 measurement

5.5 Measure plate bottom offset and position
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5.1 Well plate types

There are three different classes of well plate types which can be selected when setting up a scan.

Well pattern Positions in well

1

384 Well PS (GREINER 781-165)

6 Well PS (NUNC 140675)

12 Well PS (NUNC 150628)

24 Well PS (NUNC 142475)

48 Well PS (NUNC 150687)

96 Well PS (NUNC 167008)

384 Well PS (NUNC 164564)

24 well (Zell-kontakt CG)

96 Well Zell-kontakt CG) Del key removes

24 Well (Zell-kontakt FC) - . selected positions (7
96 Well Zell-kontakt FC)
96 Well (MatriCal MBG096-1-2-LG)
384 well (MatriCal MBG101-1-2-LG)
1536 Well (MatriCal MBG111-1-2-LG) Columns Column spacing [pum]
Slide Holder (250-0637) 5 666 -+
4 slides 3x6
Slide 12 mm

Pattern Spacing

Row spacing [pum]

Slide 15 mm

Slide 25 mm ells selected 96
6 Well

12 well liameter [um] 6497

Specific W

24 well

48 Well Acquisition order

96 Well

384 well Field of view [um x um]
96 confocal quality Edit selection table Meander A4

V 96W
96w Edit plate types Show order

Calibration status: A1 position calibrated

5.1.1 System standard well plates

These are certain commercial plates with hard-coded dimensions using the specifications of the
manufacturers. Their parameters are not editable in the Plate Manager. The Al position of these plates
is always determined after stage initialization upon software start — and thus does not have to be
determined prior to the start of a scan.

Standard well plates are highlighted blue in the Plate Manager.

Plate

CellCycle Hela Edit selection table

Type

384 Well PS {GREINER 781-165) - Edit plate types

Calibration status: System calibrated
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5.1.2 User calibrated well plates

This can be any type of well plate in principle. Once such a plate type is calibrated by the user, the Al
position of such a plate is always determined after stage initialization upon software start — and thus
does not have to be determined prior to the start of a scan.

Calibrated well plates are highlighted green in the Plate Manager.

Plate
CellCycle Hela Edit selection table

Type
96\W Edit plate types

Calibration status: A1 position calibrated

5.1.3 Non-calibrated well plates

Before the start of a scan the user is asked to move the stage to the Al position. Non-calibrated well
plates are not highlighted in the Plate Manager.

Plate

CellCycle Hela Edit selection table

Type

Slide 15 mm Edit plate types

Calibration status: A1 position uncalibrated
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5.2 Plate type settings

@ Plate Type Settings

Type
384 Well P5 (BD FALCON 353851) 96'W Lab Standard
6 Well PS (CORNING 3516)
123 w::: Ez Egggs:gg gg;g Pattern Spacing well geometry Pattern(s) position
48 Well PS (CORNING 3548) o=
96 Well PS (CORNING 3395) Columns Column [um] snape ~point A1 measurement
324 Well PS (CORNING 3625) 12 |8 9000 - Circle - "
& Well PS (GREINER 657-160) ) G [ Gy
12 Well PS (GREINER 655-180) Rows Row [um] Well diameter [Lm]
24 Well PS (GREINER 622-160) 8 - ) - 6497 - s Measure
48 Well PS (GREINER 677-180)
96 Well PS (GREINER £55-160) Repetition |E| Use the measurement result
384 Well PS (GREINER 781-165) 7 always for this well plate type.
6 Well PS (NUMC 140675)
12 Well PS (NUNC 150628)
24 Well PS (NUNC 142475)
48 Well PS (NUNC 150627) well bottom
96 Well PS (NUNC 167008)
324 Well PS (NUNC 164364) Plate bottom properties. Offset and position calibration
24 Well (Zell-kontakt CG)
96 Well (Zell-kontakt CG) R S
24Well Zell-kontakt FC) Thickness [um] Refractive index z-offset [pm]
96 Well (Zell-kontakt FC) 186 = 1.9 | 17
96 Well (MatriCal MBGD96-1-2-LG)
384 Well (MatriCal MBG101-1-2-LG) Lower surface Lower surface
1536 Well (MatriCal MBG111-1-2-LG) variation [um] position [um]
Slide Holder (250-0637) ) Use always for this
45lides 3x6 i 230 - o EE W . plate type
g

Measure

Plate loader Border thickness (objective security)

idth [mm]

Delete

Cancel

The button Edit plate types in the Edit Scan » Plate Manager tab to open the Plate Type Settings
window. Here, new plates can be created and existing plates can be changed (geometry of the plate and
Al position). The well bottom related settings can also be found here (Well bottom box); these values
are used as starting parameters for the hardware and software autofocus. When a plate loader is used
for automated delivery of plates to the microscope, the relevant parameters can be selected in this
window as well (Plate loader box). The Plate loader parameters define the way the plate is optimally
gripped by the loading robot.

On the left side of the window, the currently available plates are listed. New plate type definitions that
are not available in the plate type list can be imported with System » Import Plate Types. You can
customize the order of the plate list by clicking on one of the plates in the list and dragging it to another
position in the list. By this means, a customized plate list can be created. This modified plate list will then
be available in Edit » Plate Manager in the Type drop-down menu.

The blue marked plates are system calibrated plates. The settings of the system calibrated plates cannot
be changed. The message “System calibrated format, Press “new” to modify the format” is shown right
to the plate type. The settings for green and white plates (“custom plates”) can be changed. For green
plates the Al position has already been calibrated (see Section 5.4, Well Measurement), whereas for
plates that are not calibrated the Al position has to be set when the scan is started.
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Delete. Click here to remove the selected custom plate type from the shortlist. Standard plate types
cannot be removed.

New. Creates a new plate type based on the selected plate type.

Type: Enter here the name of the well plate type as it is to be listed in the shortlist.

Plate geometry settings

Pattern: Columns, Rows. Set here the number of columns and rows of wells on the plate, respectively.

Pattern: Repetition. Indicates if a standard well plate has been defined (i.e. a well plate with a single A1
position) or if a special format has been defined with multiple Al positions (e.g. multi slide plate holder)

Spacing: Column [um], Row [um]. Set here the distance between the centers of two adjacent well
columns and rows, respectively.

Well geometry. Select here the Shape (circle or rectangle) and the diameter of the wells.

Pattern(s) positions: The position of the well plate pattern is defined by the position of the A1 well. It is
possible to have multiple A1 wells in order to design plate geometries with multiple sub-patterns (e.g. 4
slide holder. See Section 5.3 Defining Multi-Slide Plate Holder)

Pattern(s) positions: 3-point A1 measurement. See Section 5.4 Well Measurement.
Pattern(s) positions: Al center position only. See Section 5.4 Well Measurement.

Pattern(s) positions: Use the measurement result always for this well plate type. Uncheck this
option if you want to have the plate marked as “Al position uncalibrated” in order to set the Al position
individually on scan start.

Pattern(s) positions: Measure. Starts the Al calibration process. Please make sure a matching well
plate is available on the microscope sample holder.

Well bottom

Well bottom: Plate bottom properties: Thickness [um]. Set here the thickness of the plate bottom.
This is only necessary for systems with hardware autofocus. The value usually can be taken from the
well plate’s data sheet. Alternatively, it will be calculated from the Offset and position calibration
values once they have been measured.

Well bottom: Plate bottom properties: Refractive index: Set here the refractive index of the well
bottom material; only necessary for systems with hardware autofocus. This value will be used to
calculate well plate bottom Thickness from z-offset and vice versa.

Well bottom: Plate bottom properties: Lower surface variation [um]. Set here a value for the
variation of the z-position of the well plate bottom. This will be used as search range for the hardware
autofocus. In general this value should not be too small for successful autofocusing. If the hardware
autofocus tends to find the upper surface instead of the lower surface for a given well plate, the value
should be adjusted to be smaller than the z-offset.

Well bottom: Offset and position calibration: z-offset [um]. This is the distance the microscope z-
drive has to travel from the lower surface of the plate bottom to the upper surface. It is strongly related to
the plate bottom Thickness value: Thickness [um] = Refractive index * z-offset. When an accurate
value for Thickness has been entered, this value does not need to be measured. If high accuracy is
required, the z-offset can be measured by the system and the value for Thickness is also updated
then.
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Well bottom: Offset and position calibration: Lower surface position [um]. Set here the distance
from the bottom corner of the plate to the well bottom. If the Use always for this well plate type
checkbox is activated, this z-value is used as starting position for hardware or software autofocus. If the
checkbox is unchecked, the system will ask for the starting position on scan start.

Well bottom: Offset and position calibration: Measure. The values for z-offset and Lower surface
position can be determined by pressing this button. The actual measurement is done manually or
supported by the hardware autofocus, depending on the system configuration.

Plate border settings

Border thickness [objective security] X/Y Border [um]. Enter a value only when the plate or slide
holder extends over the insert. Otherwise use default values.

Plate loader settings

Plate loader: Grip width [mm]. Defines the width of the well plate at the height where it is gripped by
the plate loader.

Plate loader: Grip height [mm]. The height at which the plate loader fingers will grip the well plate.

Plate loader: Stacked height [mm]. The effective height of the well plate when multiple plates are
stacked.

5.3 Defining multi-slide plate holder

Edit » Plate Manager » Edit plate types opens the Plate Type Settings menu. Here also well-patterns
for multi-slide plate holders can be defined. These multi-slide plates can be loaded via robot and are
supported by the analysis software. One multi-slide consisting of several individual slides can be
analyzed in a single run.

To create a multi-slide plate, the pattern of a single slide has to be defined using Pattern, Spacing and
Well geometry. The Al position can be defined by 2-/3-point measurement or A1l center position
only. The definition of A1 has then to be repeated for each of the multiple slides. The number of slides
defined will be indicated in the Repetition field in the Pattern box.

This allows also defining all kinds or regular patterns as plate types.
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B Edit Scan X

Plate Manager  SW-Autofocus  Acquisition

Positions in well

Del key removes
selected positions

Pattern Spacing

Columns
2 . 5
Left click to toggle wells on/off
Mouse-drag (+ Ctrl) to select (deselect) wells

@Meanderwells Wells selected o
Specfic W

[ continuous Well width [um]

D] Acquisition order

Field of view [pm x pm]
Edit selection table Meander 333 % 333

Type Total positions

4 slides 3x6 Edit plate types Show order

Calibration status: A1 position calibrated

Cancel

Example for a multi-slide plate consisting of 4 individual slides with wells.
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5.4 Well Measurement

scan® requires information about the position of the first well (A1) of the plate in order to start the
automated scan. All other positions are then defined by the values given in the Plate Type Settings.
Often it is sufficient to determine the position of the well center roughly, but in some cases a more
precise measurement is necessary. The two different procedures are described in the two following
sections.

Use the measurement result always for this well plate type. Check this check box if you do not want
to repeat the Al well measurement (see below) for each scan. The stored position will then be used
each time this plate type is selected. Once the measurement has run successfully, a message in light
green will be displayed right of the Type box in the plate type settings window: “Al position calibrated”.
Plate loader operation is only possible with calibrated plates.

A1 position calibrated

@ For convenience and reproducibility it is recommended to select Types with defined first
well positions (blue / green background) whenever possible even if no plate loader robot is
used. This avoids having to set the scan starting position before each scan.

5.4.1 Well measurement: Al center position only

Al center position only. Choose this option if, for all relevant experiments for this plate type it is
sufficient to roughly set just the center position of the first well (e.g. if only central positions of each well
are to be measured).

Measure. Click here to open the Pattern Position Measurement window and proceed as follows.

@ Pattern Position measurement

1. Click Measure.

2. Move to the center of well A1 and dick OK in the live view dialog.
3. If you have multiple slides, repeat the measurement for each slide.
4. Click Save after all slides have been measured.

Cancel

1. Click Measure to open a live image window.
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2. Move the center of the first well into position.

3. Confirm by clicking OK.

4. Repeat steps 1 to 3 if more than one Al position is required (see Section 5.3 Defining Multi-
Slide Plate Holder)

5. Confirm by clicking Save

If the scan® system is equipped with an automatic plate loader, the Al position (for autoloader robot)
window will open. Click Ignore if no autoloader robot is used for this plate type.

The plate loader handles the plates by turning them by 180°. This has to be accounted for in the
measurement. Proceed as follows if a plate loader robot is to be used.

@ Al position (for autoloader robot) x

If an autoloader robot is used for this plate format, the
measurement of the position of the first well has to be
repeated with the plate turned by 180°.

Adjust for Rebot

1. Mount the plate turned by 180° as depicted in the scheme.

2. Click Adjust for Robot to open a live image window.

3. Move the center of the first well into position.

4. Confirm by clicking OK.

5.4.2 Well measurement: 2/3-point A1 measurement

2/3-point A1 measurement. Choose this option if the experiment and the plate type require a precise
determination of the first well position (e.g. when using full-in to measure all positions of one well).
Depending on the well shape (rectangular/circular), two or three points have to be set. In case of a
rectangular well shape, the two opposite corners of the well have to be set. In case of a circular well,
three points on the border of the well have to be determined.

Measure Click here to open the Pattern Position Measurement window and proceed as follows.
In case of circular wells:

1. Click Measure to open a live image window.

2. Move the border of the first well to the red cross (center) in the live image window.
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3. Click Add Position.

A1 measurement

1. Move the stage so that well A1 border is positioned at the red cross in the live image.
2. Click Add Pasition.

3. Repeat this for two other Al border positions.

4. Confirm with OK.

Zfocus XY navigation
Exposure time [ms]
500 |- |+ |Auto

Coarse -

% Binning
Ix1

Step size

3.00
ol Filter cube

DA/FITC/CyI/CYS

Objective

Current position
UPLSAPO 20x

598872 | [um]

Defined Color Channels
DAPI* =

lllumination LED excitation

Fluorescence 1 ) w
Clipping
0%

2048x2048 0.25X 6  (0,0)
Ocular view

4. Repeat this for two more well-border positions.

5. After the third position has been added, the numbers field next to the Add Position button
turns green to indicate that the measurement is completed. Confirm by clicking OK.

Add Position

6. Repeat steps 1 to 5 if more than one Al position is required (see Section 5.3 Defining Multi-
Slide Plate Holder)

The three positions per well are used to determine the Well diameter (that will be set automatically in
the Plate Type Settings window) and the center position of well Al.

If the scan® system is equipped with an automatic plate loader, the Al position (for autoloader robot)
window will open. Click Ignore if no plate loader robot is to be used with this plate. Click OK to repeat
the measurement with the plate rotated by 180°.

@ Al position (for autoloader robot) b4

If an autoloader robot is used for this plate format, the
measurement of the position of irst well has to be
repeated with the plate turned by 180°.

Ignore Adjust for Robot

In case of rectangular wells:
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1. Click Measure to open a live image window.

2. Move to a corner of the first well (Al) to the red cross.

3. Click Add Position.

4. Repeat this for the opposite corner of the well (the numbers field next to the Add Position
button turns green to indicate that the measurement is completed).

5. Confirm by clicking OK.

6. Repeat steps 1 to 5 if more than one Al position is required (see Section 5.3 Defining Multi-
Slide Plate Holder)

The two positions are used to determine the well height, well width and the center position of well Al.

5.5 Measure plate bottom offset and position

For fast automated focusing, at least the position of the “upper surface”, e.g. the plastic-buffer interface
of the well bottom where the cells are adherent, needs to be known. For hardware autofocus operation,
also the position of “lower surface” should be known to increase speed of the autofocusing procedure.

If the system is equipped with the hardware autofocus option, the acquisition software will detect the
lower surface of the sample automatically. Therefore go to the Edit » Plate Manager » Edit plate type
window and click on the Measure button in the Well bottom area. The measured value for the lower
surface will be entered as Lower surface position [um]. After that the Plate surface measurement
window will appear.



scan® Acquisition Software Chapter 5 — Well Plate Library

i Plate surface measurement

Upper surface Please focus on the UPPER surface, then press Set

Exposure time [ms]
500 [= [+ |Auto

Binning
Txl

Filter cube
DA/FITC/CY3/CYS

Objective

Ll UPLSAPO 20x o

Defined Color Channels

DAPI* =

lllumination LED excitation
Fluorescence % v

Clipping
0%

2048x2048 0.25X 6 (0,0)
Ocular view

Define upper surface of a plate

Here you have to focus the sample manually, either by using the up/down buttons for Coarse and Fine
or by using the microscope wheel. Press the Set button to define the upper surface of the well bottom.
The z-offset and indirectly also the Thickness of the well bottom (coverslip) will be calculated from the
measured values.

Note that if no hardware autofocus is present, two windows will appear after the Measure button is
pressed: one window to measure the upper surface of the sample and a second window to optionally
also measure the lower plate surface.

If these measurements have been performed successfully, in both cases the upper surface of the
sample will be indicated in all Z focus sliders by a blue bar.
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6 Running a Scan

This chapter explains how to start a scan and the steps that are necessary once a scan is started and

the actions and online observations possible in the course of an experiment.

6.1
6.1.1
6.1.2
6.2
6.2.1
6.3
6.4
6.5
6.6
6.6.1

Systems with hardware autofoCUS ...........coevvviiiiiiiiiene e 67
Plates with predefined AL POSItiON..........cccccvviiieeee i 67
Plates/Slides without predefined AL position...........ccccvvvvveeeeeeiinnee, 67
Systems without hardware autofoCUS ..........coovvvviiiiieiiiiiiiiiiee e 69
Plates with predefined AL POSItION..........oovviviiieieeiiiiiieie e 69
Autofocus adjustment during @ SCaN........ccvevveeeeeeiiiiieeee e 71
Online image browSiNg ........c.uvvviiieiiiiiiiiiiiee e e e 71
ONliNE @NAIYSIS. ... .iiiiiiiie i 72
Systems with automatic plate loader ..........cccoocvviviiiiiiiiiiiiiiieeees 74

Plate LOAAEr SCAN ...uvvviiiiiiiiiiie ettt e e e e e eaees 74
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For scan” to perform a proper scan, it is required that all Autofocus, Acquisition and Plate Manager
settings in the Edit Scan window are properly set; see Chapter 4, Setting up a Scan.

After starting the scan by clicking Start, there are different scenarios depending on

¢ the availability of a ZDC hardware autofocus

¢ the usage of plates with or without predefined starting position

These different scenarios are explained in the following chapters.

6.1 Systems with hardware autofocus

The hardware autofocus enables fast and reliable detection of the well plate focus position, even if there
is a stronger variation from plate to plate. This means the system can detect the focus fully automatically
and no user interaction is required at scan start. If the Offset and position calibration has been
performed (see Section 5.1, Well Plate Types) and the Use always for this well plate type option is
checked, the system hardware autofocus will use the calibration and can be much faster for the first
position.

6.1.1 Plates with predefined Al position

This is the simplest scenario. A system with hardware autofocus and a plate type with predefined
starting position, i.e., either system standard or A1l position calibrated plate types.

Upon a click on the Scan: Start button scan® conducts the entire scan automatically as set up in Edit
Scan and stores the focused images in the predefined folder.

6.1.2 Plates/Slides without predefined Al position

In case of commercial plates of one and the same type, one can in most cases assume that upon
mounting on the stage the position of well A1 will always be at the same position, and the following
scenario will not apply.

In case of spotted slides and non-calibrated plates, however, scan® needs to be taught the starting
position each time anew.
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1. Click Scan: Start to start the scanning routine. The following message will appear:

EZ A1 position *

Well A1 position has not been set.

Set Use previous

Use previous. This option is useful if a scan is to be repeated with the same slide immediately.

B Scan Starting Position

No starting position for the scan has been set.

1. Mave to the center of the first (upper left) well.

2, Click Select to set the starting position.

3. Repeat these steps for each slide — if more than one plate is mounted - after setting the next slide position.
4. Click OK to confirm.

Zfocus XY navigation

Coarse - | Fine

+ g +

Step size
300 | fum]

Current position
6109 | fum)

Defined Color Channels
Autofocus -

45785
0% cipping
Select
Clipping

v . starting position
0% - - ' * . 4 iy ‘ for slide:

048:2048 0.25X 6  (1608,732) L

Ocular view

2. Click Set to open the Scan Starting Position live image window.

3. Move to the center of the first (upper left) well.

4. Focus the specimen using the Z focus tools.

5. Click Select to set the starting position for slide 1.

6. Repeat these steps for each plate — if more than one plate is mounted. Make sure to set the
correct slide number each time.
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7. Click OK to confirm.

8. scan® conducts the entire scan automatically as set up in Edit Scan and stores the focused
images in the predefined folder.

@ Note that the positions you define refer to the center of well Al of the well pattern and thus
not necessarily to the first well activated for acquisition in the Edit Scan » Plate Manager
window!

6.2 Systems without hardware autofocus

System without hardware autofocus usually require user interaction on start of a scan because the
variations of the bottom of typical well plates can vary from plate to plate. In this case it usually is faster
to provide the focus for the first position manually in contrast to using exhaustive software autofocus. If
the Offset and position calibration has been performed (see Section 5.1, Well Plate Types) and the
Use always for this well plate type option is checked, however, the system will start with the focus
values from the well plate library. This can be useful for very precise (highest quality) well plates or
batches of plates with low focus variation.

6.2.1 Plates with predefined Al position

1. Click Scan: Start to start the scanning routine. The following message will appear:

& *

You have to set an initial z / focus position

Teach new Use previous

Use previous. This option is useful if a scan is to be repeated with the same plate immediately.

2. Click Teach new to open the Autofocus Starting Position live image window.



70  Chapter 6 — Running a Scan OLYMPUS

ED Autofocus Starting Position

The software autafocus requires a starting position.
1. Focus the specimen.
2. Click OK to confirm.

e T R T e T e T
% W $

Zfocus XY navigation

Step size
3.00 [um]

Current position

601255 | [

Defined Color Channels
Autofocus - Save

Clipping
0%

2048:2048 0.25X6 (0,0)
Ocular view

3. Focus the specimen using the Z focus tools.

4. Click OK to confirm.
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6.3 Autofocus adjustment during a scan

Click the Autofocus Settings button on the main window in order to optimize the software autofocus
during a scan. The Autofocus Settings window opens. The upper box affects only the settings of the
object-based autofocus. The options of coarse and fine autofocus can be tuned and the exposure time
of the autofocus channel can be changed.

Object-based AF settings

U n [®] ptinimum size ] Mximum size

[pixels]

Coarse autofocus Fine autofocus

Layers 14 |2 Layers| 9

Step width 1125 |[= Step width|  2.81

Scan range [um] Scan range [im]

160 80 60 13

‘Camera

Exposure time [ms]

20 -+

Cancel

The controls are explained in detail in Chapter 4.2, Autofocus Settings.

6.4 Online image browsing

Click the Online Observation: Browse Images button to browse through stored images of the current
scan. It is also possible to open previous scans for quick review.

Use the Previous and Next buttons to navigate through the images.

Delete associated images. Removes associated images, e.g. the images of one color channel.
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B image Browser

Image name

Previous Mext

Delete position

Refresh directory listing

Wiell

1 B
Position

1 s

Color

Cy3_confocal ~

2048x2048 0.33X Signed 16-bitimage 13 (1820,377) % intensity clipping 0 -

Path to experiment description

Di\Data'Screens' CellCyle Hela_D02\experiment_descriptorxml =

Status
oK QK

Refresh directory listing. Updates the list of available images (in cases where acquisition is still
ongoing)

Well/ Position / Color/ Z/ Time. Use these buttons to navigate through the images.
Generate AVI. Set a file to export an .avi file for time-lapse experiments.

Path to experiment description. Displays the path to the current scan or sets the path to an
experiment descriptor file to load other data that were previously acquired.

6.5 Online analysis

After starting the acquisition it is possible to directly start the analysis of the experiment. To do so, start
the scan® Analysis software and load the experiment_descriptor.xml file manually by executing Scan »
Open... or use Scan » Open Last Acquired to open the experiment currently running. Set up a new
analysis or load an existing assay file as described in the scan® Analysis Software manual.

After the acquisition and analysis are completed, it is possible to revisit the objects that were detected
during analysis. Therefore go to Repositioning » Interactive in the analysis software.

The Interactive Repositioning window opens. Now the Analysis software will work together with the
Acquisition software in order to control the microscope. Select an object in the scan® Analysis software,
i.e. click either on one of the data points or on a detected object in one of the image displays (main
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image panel, galleries). After selecting an object, the stage moves back to the position and shows a live
view. Thereby the object selected in the scan® Analysis software is centered.

Select the color channel to be displayed in from the short list. The sample can be focused with the Z-
control in case a Z-drift occurred in between the first measurement and the repositioning. The Ocular
view allows to inspect the ‘hits’ detected by the analysis by eye.

In the case that the scan® analysis software is running on a different computer than the acquisition
software, it is necessary to set the IP address (Allowed hosts) and the port (use default 2055) of the
computer, where the analysis is running (see Chapter 8.1.4, Error Reporting / Remote). In the scan®
Analysis software, open Preferences and in the Repositioning & Reclassification box enter the Port
of the Acquisition Server (2055) as well as its IP Address (see also scan® Analysis Instructions,
Chapter Preferences).
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6.6 Systems with automatic plate loader

A scan” system with automatic plate loader allows screening several well plates within a single run. Up
to five stackers or shelves are available and will be positioned on the right of the robot. In stacker
operation, one of the stackers has to be empty at the start of the scan and will serve as swap stacker.
Optionally, there is an additional position (re-grip station), which is used for fine positioning of the plates.
Keep this position empty. You can remove the stackers/shelves from their positions to make loading and
transportation easier.
When loading the stackers, take care of the following:

- Start with filling stacker 1, then 2, etc.

- Orientate the plates with the first column pointing towards the microscope.

- Make sure that each stacked plate fits accurately on the plate below.

- Stack the plates as well aligned as possible.

— Leave a minimum gap of at least 10 mm from the last plate to the top of the stacker to allow the
robot to lift the uppermost plate from the stack.

S frewer | .
.’ . . ) =
| N Ml B [a]fg
1 N /’ A} <
; _ _‘ <
] . ’ ! b4
icks 1 N r |
i : v
[ 4 a
b IF re- 4 [AL
. | i
microscope| .
. robot range
system base plate

When loading the shelves take care of the following:
-  Start with filling shelf 1, then 2, etc.
—  Start filling from bottom to top
— Orientate the plates with the first column pointing towards the microscope.

- Make sure that each plate fits accurately on its floor.

6.6.1 Plate Loader Scan

Select Operate » Plate Loader Batch Scan to start a screen using the automatic plate loader. The
current experiment settings will be used to scan each plate.
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ﬁ Plate Loader 5can —

Basic  Advanced
Press Start to scan all plates.

Info

Plate Name: CellCycle_Hela
Plate Type: 96 Well Plate
Storage Directory: D:\Data

Status: Close Start

The Plate Loader Scan » Basic tab gives a brief overview of the Plate Name and Plate Type settings,
and of the Storage Directory which will be used for the automatic scan. Press Start to start the screen
of all plates on the shelves or stackers.

ﬁ Plate Loader 5can —

Status: | Starting scan.. Close Start

This will initialize the automatic plate loader, deliver the first plate the microscope, start a scan with the
current experiment settings and store the images at the specified Storage Directory. During the screen,
the Status field will continuously provide information about the current status and progress.

scanR Acquisition - o x

File View Opemte System About

Status:  Scanning plate 1 frem hetel 1.
Settings Online observation Plate: CellCycle Hela
3101112

Browse Images

Settings Autofocus

FITC ¥ Display AF [[] 2048:20480.17¢ 111 (263,

Position 1 of 1 Cyde 1 of Plate 1 Time remaining: 00:06 h:min Progress:
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The Plate Loader Scan » Advanced tab provides options for more advanced configuration.

@ Plate Loader Scan -

Basic Advanced

[]Use import file for plate naming and well selection

=
Create new subdirectery for this batch scan:
%Y-%em-%d Batch
[JRemove lid for scanning
Restore order of plates on stackers
Status: Close Start

Advanced: Use import file for plate naming and well selection. Allows selection of a file with well
plate names, and well selections and descriptions to better customize the documentation and selection
of wells to be scanned for each plate.

Advanced: Create new subdirectory for this batch scan. When checked, this option will create a new
subdirectory in which all scans collected for better documentation and data handling. The directory
name provided here can include special variables which will be replaced by the current date or time.

Special variable example Resulting directory name example
%Y 2017 (year)

%m 10 (month number, i.e. October)

%d 26 (day of month)

%Y-%m-%d Batch 2017-10-26 Batch
%Y-%m-%d_started-%H:%Mh Batch 2017-10-26_started-13:15h Batch

Advanced: Remove lid for scanning. For well plates covered with lids. The lid will be removed after
the plate has been delivered to the microscope and returned to the plate when the scan has finished.
Using this functionality ensures the well plate is protected most of the time and only left without lid for the
actual scanning process.

Advanced: Restore order of plates on stacker. This option is enabled by default. If disabled, the
system will not use the empty stacker as swap stacker and restore the plate order afterwards. It rather
will store them as time efficient as possible. This means, the top plate scanned first from stacker 1 will
be the bottommost plate on the originally empty stacker and so on.
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7/ Multi-level Screening

This chapter explains how to set up and perform a multi-level scan.

7.1 OVEIVIEW ..cooiiiiiiiiee ettt e e e siivneeaa e e e
7.2  Setting up a multi-level scan.....................
7.2.1 Theinitial SCAN........coccveiiiiieeeee e
7.2.2 The analySiS......cccccvviiiiiiiiiee e
7.2.3 The reSCaAN .....uvviveeeeeeiiiiiiee e e e eecreea e
7.3  Running a multi-level scan.............cccccco..

Chapter 7 — Multi-level Screening
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7.1 Overview

Multi-level Acquisition is a powerful means of screening all interesting views of a sample with the best
possible parameters in a minimum of time and with maximum flexibility. Based on an initial pre-scan, the
scanR Analysis software determines all interesting objects with the complete image processing, image
analysis, and cytometric data exploration engine available. In an automated workflow, the analysis
results are employed to scan selectively only the objects-of-interest in a second, targeted screen.
Typical scenarios where Multi-level Screening excels are large area sample with few cells which require
high resolution or single cell events.

7.2 Setting up a multi-level scan

Select Operate » Multi-level scan in the main window. This command opens the Multi-level Scan
wizard.

@ Multi-level scan EI =] =3

Initial 5can | Analysis | Rescan

Configure an initial scan to locate ohjects of interest.

Scan Configuration

Ch\Users\ OsisAdmin'\Documents'\ScanR\Scan Settings\First_MLS_20xaml | [ Edit

Scan

Status: ‘ Close | ‘ Start ‘

A multi-level scan consists of three steps. These steps correspond to the three tabs of the wizard.

1. The Initial Scan. This, for example, can be a fast low-resolution scan of the whole sample

2. The Analysis of the initial scan. In this step, the interesting objects or positions in the sample
are discovered by the scan® Analysis.

3. The second scan, or Rescan, of the same sample using information from the previous
analysis. This, for example, can be a targeted high-resolution scan of the objects of interest
only.

Each step can be set up and tested individually using the respective tab of the wizard. Once the multi-
level scan has been set up correctly, it can be started using the Start button. The Status line will show
information about the progress of the multi-level scan as well as information about the result of individual
steps during the set-up process.
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7.2.1 Theinitial scan

On the Initial Scan tab the configuration for the initial acquisition is defined. There are two options to
start with setting up this step. By selecting the folder icon @ any experiment_descriptor.xml file from
previous scans can be loaded from disk. Alternatively, the New button generates a copy of the scan
settings currently active in the scan® Acquisition software. Using the Edit button, the initial scan can be
modified as usually (see Chapter 4, Setting up a Scan). By clicking the Scan button, the defined initial
scan will be started directly. In contrast to using the Start button, which executes all three steps of the
multi-level scan automatically, starting only the initial scan manually can help setting up the multi-level
scan and finding the best possible parameters for the initial scan.

7.2.2 The analysis

The Analysis tab is used to set up the analysis step of the multi-level acquisition.
ﬂ Multi-level scan EI = | ==
Analysis Rescan

Select an assay to detect objects you want to image in the following scan.
All objects in the configured gate will be scanned.

Assay
ChUsers\ OsisAdmin\Decuments\5canR\Assays\ Golgidssay.say
Gate
RO1 Iz‘ Run
Status: l Close l l Start ]

There are two options to start with setting up this step. By selecting the folder icon \EI any scanR
Analysis assay file (*.say) can be loaded. Alternatively, the New button generates an empty template for
setting up a new assay for analysis. Using the Edit button, the assay will be loaded in the scan® Analysis
software and can be modified there as usually. It is important that the selected analysis assay file
contains at least one gate. Using the Gate dropdown box, a gate can be selected. All objects which fall
in this gate when analyzing the initial scan will be re-scanned when the multi-level scan is started. The
settings can be tested using the Run button if an initial scan has been performed in the first step of
setting up the multi-level scan. As soon as the test run has been finished, the Status line will show the
number of objects found during analysis. These are the candidates for the rescan.

7.2.3 Therescan

The Rescan tab is used to define template experiment settings for the rescan of objects found during
the analysis of the initial scan.
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@ Multi-level scan E' [E15]| 23

| Initial Scan | Analysis | Rescan |

Configure a second scan to image objects of interest,

Scan Configuration

Ch\Users\ OsisAdmi..\ScanR\5can Settings'\Second_ML5_d0x.xml [ || MNew Edit
Autofocus Options
Hardware SW Coarse V| SW Fine Scan
Status: ‘ Close | ‘ Start ‘

As in the other steps, there are two options to start with setting up this step. By selecting the folder icon

= |, any experiment_descriptor.xml file from previous scans can be loaded from disk. Alternatively, the
New button generates a copy of the scan settings used in the Initial Scan tab.

Using the Edit button, the rescan scan can be modified as usually (see Chapter 4, Setting up a Scan)
with the exception that the plate settings cannot be modified. This is the case because the plate
definition cannot change between initial and rescan, of course. Only the autofocus options applied at
each position during rescan can be selected in the tab directly.

When the first two steps (initial scan and analysis) of the multi-level scan have been performed during
set-up of the multi-level scan, the Scan button can be used to start the rescan with the defined settings
directly. In contrast to using the Start button, which executes all three steps of the multi-level scan
automatically, starting only the rescan manually can help setting up the multi-level scan and finding the
best possible parameters for the rescan.

When using different microscope objective lenses for the initial scan and the rescan,
respectively, and using hardware autofocus for the rescan, it is important that hardware
autofocus parfocality has been calibrated carefully (cf. Section 8.4)!

7.3 Running a multi-level scan

Setting up a multi-level scan requires some care and accurateness because all three steps need to
execute successfully and consecutively with the desired intermediate results. For this reason, each of
the three steps (initial scan, analysis, rescan) can be run individually during the set-up and optimization
phase as described above until they are optimally configured.

Once the multi-level scan is set up successfully, the Start button can be used to run the complete multi-
level scan for a given sample. When the multi-level scan has been started, the wizard window will be
reduced to show only the status line.

ﬂ Multi-level scan EI [El|| 22

Status: | Starting initial scan... Close Start
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Without user interaction, the multi-level scan will run completely until all three steps are finished. If
desired, the process can be interrupted using the Stop button in the scanR Acquisition main window as
usually. In case the initial scan is stopped by the user, a dialog will pop up with two options to choose
from.

@ Centinue multi-level scan? @

Initial scan has been stopped.
Continue with analysis and rescan?

l Continue l ‘ Abort |

By clicking Continue, only the initial scan will be stopped but the multi-level scan will be continued, i.e.
the data acquired so for will be used for the analysis and rescan steps. Selecting Abort, on the other
hand, will stop the multi-level scan completely.

When the multi-level scan has been completed, the results of the rescan will be stored as subfolder in
the directory defined and used for the initial scan. The name of the subfolder always is rescan_001
where the number will be increased for each rescan if multiple rescans are performed during set-up
phase. For analysis, the rescan can be opened from scan® Analysis software as usually.
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8 System Configuration

Chapter 8 — System Configuration

This chapter explains how the system devices have to be configured in order for scan® to work properly.

8.1  System configuration ..........ccccccovvvvrreeennnn.
8.1.1 DEVICES ..oveiiiiiieeiieie et
8.1.2 MICIOSCOPE.....cuvviiiieeeeeiiiiiriieeeeeeesiiareeeaeens
8.1.3 MT20/LED.....coiiieiiieiie e
8.1.4 Error Reporting / Remote...........cccvvvveeen..
8.2  Stage Calibration ..........cccccvveeeeiniiiinieennn.
8.2.1 Stage Calibration Procedure.....................
8.3  Objective Parfocality ........ccccceeeeeeiiiiinnnnnnn.
8.4  HW-AF Parfocality .........cccvvveeeiiiiiiiiiinnnn.
8.5  Shading Correction .........cccccceeeevviiiineeennnn.
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8.1 System configuration

Upon installation of the scan® screening station all hardware components have to be configured for the
system to work properly. The configuration has to be adjusted if changes are made, for example, if new
filters or objective lenses are added.

The execution of the System configuration command is password protected.

The System » System Configuration command gives access to the Hardware configuration window
with different tabs (see following chapters):

e Devices and ports to select the available hardware components and configure the PC ports

e Microscope to view the configured objectives, filters and contrast inserts

e MT20 to view the configured excitation filters of the fluorescence illumination system

e Error reporting

e Remote

The System » Calibrations menu provides a number of calibration wizards to set up the system
optimally. For example, the Calibrations » Stage Calibration command allows an absolute calibration
of the stage with a system calibrated well plate type as reference. This is not to be confused with the

stage initialization that is being carried out each time the software is started (see Chapter 8.2, Stage
Calibration).
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8.1.1 Devices
EZ System Configuration *
Devices Microscope  MT20/LED  Cenfocal  Errorreporting Remote
Fast turret [X2_FRFACA
Enable fast HW-AF made  []
Enable DIC HW-AF mode  []
Stage COME e
Type Tango Speed
Dual camera Switch order
Mirror camera 1 O Mirror camera 2
Field of view mode Full field of view (18,8 mm) w
Cancel oK

UCB. Select the serial port (RS232) of the imaging PC that is connected with the universal control box
(UCB) (1X81 only).

Transmission shutter. Check this box if a shutter for transmission mode is connected. Some shutter
types will be auto-detected and the box checked automatically.

Fast turret IX2_FRFACA. If a fast filter turret is available, this is automatically checked (1X81 only).

Hardware autofocus. Check this box if a ZDC hardware autofocus device is connected and should be
used by the system. For newer system configurations, this box is checked automatically.

Enable fast HW-AF mode. Activates fast hardware autofocus mode (available only with the 1X3-ZDC2
hardware revision of the ZDC autofocus device).

Enable DIC HW-AF mode. Activates DIC optimized hardware autofocus mode (available only with the
IX3-ZDC2 hardware revision of the ZDC autofocus device).

Stage. Select the serial port (RS232) which is connected to the stage controller. Older systems might
have other connection types which do not need to be configured here.

Stage: Speed. Click here to open the Stage speed window if you do not want to use the default settings
for stage speed and acceleration. Change the Velocity and the Acceleration using the respective
sliders for movements during a scan (System Control) and for movements under Joystick control.
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Dual camera. Activates dual camera mode if two cameras are connected to the system (optional).

Switch order. Reverses the order of camera #1 and camera #2 if two cameras are available.

Mirror camera 1/2. Applies vertical flip to the respective camera image. This is required for beam slpitter
configurations, for example with the CSU (optional).

Field of view mode. For systems equipped with a large field of view camera, the field of view can be
reduced in order to reduce possible shading effects or to be backward-compatible to the 2/3” sensor
industry standard.

8.1.2 Microscope

E Systern Configuration >

Devices and ports  Microscope  MT20/LED  Errorreporting  Rernote

[#]Glebal objective change

Water immersion

Initialization volume [mL] Velume for new plate [ml]

4.0 = 1.00 =

Velume per hour [mL/h]

Disable objective movement [

Cancel oK

These settings mainly are displayed here only for reference. They are configured in the OBS System
Configuration. Settings for the water immersion module can be done directly in scan®.
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3 OBS System Configuration — >
Mosepiece
General =
Excitation Filters
Burner CObjectives
| Full Control Magnification  Mame Refraction Correction
4 Microscope L 3 —1 oEmo o [
General '
2 [ w| JuetFnzeH ~| [03 [ 1.0 [ 1.0
Deck 1 | T 1 S | -
e — — 32 dl | UPLSAPO hdl |0.75 | 1.0 | 1.0
Contrast Inserts r . .
Filters 4 |20 | |uceLFLM ~| Jo7 [ 1.0 [ 1.0
| Shutter : :
| Stage 5[40 ~| |upsapo2 | Joss [ 1.0 [ 1.0
6 |40 | | LUCPLFLM PH 1.0 1.0

Ok Cancel

Objectives. Shows the microscope objective lenses configured in the OBS System Configuration for
each nosepiece position.

Filter cubes. Shows the filter cube names for all positions in the filter cube turret as configured in the
OBS System Configuration.

Global objective change. Generally, in each channel (AF, color channels) the objective can be set
independently. In order to facilitate the operation of scan®, the objectives can be changed for all
channels simultaneously (this checkbox is activated by default for all new scan® installations). If the
checkbox Global objective change is activated, the change of the objective in one channel will lead to
a simultaneous change of the set objective in all other color channels. In this case also the fine range
step width of the software autofocus (See Chapter 4.2.1, Fine Autofocus) is automatically adapted to the
selected objective.

Contrast insert. Shows the names of the transmission condenser inserts as configured in the OBS
System Configuration.

Emission filter FFWO. Shows the filter names for all position in the emission filter wheel as configured
in the OBS System Configuration.

Automated Water Immersion System IX2-AWI (optional, 1X81 only). An automated water immersion
system is available as an option for scan®. The system supports either the 40x objective
UAPO40X340W/1.15 or the 60x objective UPLSAPO60XW/1.2. With this device high resolution and very
low light screening applications can be performed with scan®.

Initialization Volume [ml]. The volume of water that is dispensed during startup.

Volume per hour [ml/h]. The volume that is dispensed within one hour. From time to time the pump will
start to dispense a part of this volume. The maximal value is limited by the pump rate. The Volume per
hour may have to be adapted depending on plate types (flat glass bottom or foil plate with dents) and on
the type of pattern that is used to screen the plate.

Volume for new plate [ml]. The volume that is dispensed when a plate is changed during acquisition by
a plate loading robot. To check this volume during configuration press the adjacent button Dispense. If
a plate is changed manually press the Dispense button at the front of the IX2-AWI control box.
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Disable objective movement: if this checkbox is activated, the movement of the microscope objective
revolver is disabled.

For a more detailed description of the automated water immersion and its operation in scan® please
refer to the IX2-AWI manual.

8.1.3 MT20/LED

LED controller. This option is available only for scan® systems equipped with an LED light source.
Select the serial port where the LED light source is connected to.

LED TTL-Signal. This option is available only for scan® systems equipped with an LED light source. It
determines if the LED operates in TTL Low or TTL High mode. Switch this option if LED channels
appear to be always on.

Switch off burner after acquisition. This option is available only if the scan® system is equipped with

an MT20 light source. Check this box to cause the arc burner to be switched off automatically after the
scan is completed.

o This is a useful option for weekend or overnight operation because it saves burner lifetime.
Mind, however, that the burner needs about 10 min on restart to reach full and stable
intensity. Also, switching the burner on and off frequently reduces the lifetime. It is not
recommended to activate this switch if expected idle time of the system is less than an hour.

Excitation filter / LED excitation channels. Shows the filter names for all positions of the MT20 filter
wheel as configured in the OBS System Configuration, or the definition of the LED excitation channels.
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@ System Configuration x

Devices and perts Microscope MT20/LED  Errorreporting  Remote

LED centroller COM3 %

LED TTL-Signal Low ~

Switch off burner after acquisition

LED Channel Mame Trigger LED

1 A Red
2 B Green
3 C Cyan
4 1 uy
5 2 Teal
] 3 Blue
Cancel 0K

The settings for LED allow definition of the LED channel Names

8.1.4 Error Reporting / Remote

Error reporting

Error reporting. Check this box if you want error messages that may be generated during a scan to be
sent automatically as emails.

Email address and SMTP. Make sure to set the correct addresses here.
Subject and Body. You may enter default content here to be sent in addition to the error message.
Remote

The information here is needed to allow communication between the scan® Analysis software and the
system from a remote PC or to control scan® by another software (see Section 9.3, Remote control).

Make sure that remote access is enabled in the corresponding settings of the operating system.
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@ System Configuration * @ Systern Configuration *®

Devicesand ports  Microscope  MT20/LED  Errer reporting  Remote Devices and ports  Microscope  MT20/LED  Errorreporting  Remote

[Derror reporting

Allowed hosts

10.211.178, localhost

Cancel QK Cancel oK

Port and Allowed hosts. Make sure to set the correct addresses here to allow remote access to the
system.

8.2 Stage Calibration

When the scan® Acquisition software is started the stage initializes automatically to determine its
maximum limits of movements.

When a system is set up initially or maintained later, the stage needs to be calibrated. More precicely,
the position of the well plates relative to the absolute stage coordinates is calibrated and saved. This is
not a procedure that has to be undertaken routinely, it suffices to do it once upon installation of the
system. Furthermore is has to be done very accurately because it will affect all plates defined in the
Plate Library. Thus, the access to this routine is password protected.
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8.2.1 Stage Calibration Procedure

E Corner selection for calibration x

Please select the stage frame corner which will be calibrated,

left right
up Corner hor, position
" a1 Left ~
@ Please choose Plate for Systemn Calibr., = Corner vert. position
low Low w

Well plate type
24 Well PS (BD FALCOM 353047) - 1

The calibrated corner is at the

opposite side of the hook Cancel OK

1. Place a system standard well plate on the stage and select the well plate type in the Plate
Format window.

2. Execute System » Stage Calibration.

3. Perform the 3-point A1 Measurement as described in Section 5.4 Well Measurement.

Once the procedure is completed the stage is calibrated and the Al position of system standard as well
as calibrated well plates will always be located at a known position.

8.3 Objective Parfocality

This command allows you to set an offset for the Z-position for the used objectives, so that when
changing the objective, the focus is maintained.

1. Execute System » Calibrations » Objective Parfocality.

2. Select the first objective to be used from the Objective short list (e.g. UPLSAPO 40x). (It is
convenient to start with the objective which has the highest magnification).

3. Set the focus by using the Z-focus wheel on the microscope until the sample is focused or by
using the Z-focus arrows/slider.

4. Make sure that the Parfocality value for the first objective is set to 0.
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| [ Partocaity setup
|

f—

Carnara
oo XY awagaton
et Exposure time [ma]
3800 . -
W00 &
ey Coarse fine Autoret
= Bieing
.]N} Tl
2000 =
3 - Microscope
Shep tuze
00
200 30| tumi Fiter cube
i MEDAFCICS SEM o
000
1500 Dbjective
Cumres arbicn
e o pe UPLSAPO 240 |v
@ | fym)
100
" Parfucalty fm]
00 o
0 Defined Color Chamnels
w o ) | T
T
[AFlusrescence LED excitation
[ Otesncenssion Green (5015 [
Clippang
Histogram Intensity 100 *
13024 10158 (810,302) 1% 100 %
Focus Orecular view
Cancel oK

5. Select the next objective from the Objective short list (e.g. UPLSAPO 10x). At first the image
might be blurred.

6. Set the focus for the second objective by using the up and down arrows in the Parfocality
field.

| [ Partocaity setup

400 Camners
y Zioous | XV amagation
et Expogure time [ma]
100 %0 15
w

= Cearse fine Auto set
1000 o

e

2000 g

4 - Mecruscope

Step saze
200
300 | wm
= [ Flter cube
we

MEDAFICICS SEM o

Objective
Cumres arbicn
e o pe LUCPLILN 20 PH
522095 | [um)
o
= Parfacalty fum]
00 £
0 Defined Color Chamnels
' B o - =
& L i

[AFlusrescence

!D [ Teantmissson

Clippang

Histogram e = 3
13441004 100 117 (724,526) 1% %
Foeus Creutar view
Cancel oK

7. Repeat steps 5 and 6 for all other objectives for which parfocality is to be set.

The focus position will now be maintained when changing the objectives.
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8.4 HW-AF Parfocality

Similar to the objective lens itself, the ZDC device (which is used for hardware autofocus in scan®) might
also have some variation in the determined focus position for different objective lenses. To compensate
for this, the hardware autofocus parfocality can be calibrated.

1. Before calibration of HW-AF Parfocality it is important to have Objective Parfocality calibration
completed.

2. Execute System » Calibrations » HW-AF Parfocality. The HW-AF Parfocality overview
opens which can be used to review the calibration, start the calibration procedure, or reset the
calibration.

= HW-AF Parfocality

Current Configuration
Objective Glass/Plastic (~170um)  Plastic (~1mm]
UPLSAPO 4x -

UPLFLN 2 10x PH
UPLSAPO 20x
UCPLFLN 20 -2.98 62,93
UPLSAPO 2.40x -443

LUCPLFLM 40x PH -7.08 -240.39

Measure Glass Measure Plastic

Reset Glass Reset Plastic

oK Cancel

3. Press the Measure button to start the calibration procedure. If the IX3-ZDC2 revision of the
ZDC device is installed in the scan® system, the procedure can be started for thin (plastic or
glass, ~170um) plates or thick (plastic, ~1mm) plates separately.

4. For the calibration procedure you will need a well plate (or two different well plates in case of
IX3-ZDC2). It is recommended to use the plate type which will be used later for the actual
measurements. If multiple plate types will be used, it is best to choose the plate with the
highest quality for the calibration procedure.

5. A Live View window is displayed as preparatory step for the automatic calibration. Here it is
necessary to focus manually on the lower surface of the plate to provide the reference
measurement. Usually it is possible to focus on the lower surface even of an empty plate
because there are tiny scratches or dust particles. If the lower surface is not visible, it can be
marked with a felt pen to find it more easily. It is important to focus on the lower surface as
accurately as possible using the objective lens with the highest magnification.

6. Press OK to start the automatic calibration process. The system will select all objective lenses
compatible with the hardware autofocus and measure the focus position, thereby determining
the optimal correction value (if any).

When HW-AF calibration has been done successfully, the autofocus measurements will be independent
of the selected objective lens. This is prerequisite to use one plate definition with all objectives together
with hardware autofocus.
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8.5 Shading Correction

The Shading Correction Image Manager is the central location to review and acquire the reference
images used for the shading correction. At least one image per color channel is required for correction of
inhomogeneities of the illumination and shading of acquired images by the optical properties of the
microscope system. This reference image can be taken individually for each color channel and objective
setting. Additionally, a dark image can be acquired to correct for dark noise induced by the camera.

1. Execute System » Calibrations » Shading Correction.

[P g Corraction Image Wanages " ==

Color Channels Correction Image (Thumbnail)
DA -
TxRed

FITC

Trans

< <Darklmage>>

Magnification Changer
1.0x
16x
2.0x

Objectives Selected Objective(s) for Acquisition

UPLSAPO 40x

UPLFLM 10x PH

< <

Start Acquisition

2. Select a color channel from the list of available Color Channels.

3. Select an objective from the Objectives list to review the available shading correction data for
this combination of color channel and objective. A thumbnail of the correction image will be
shown if available.

4. Select one or more objectives for acquisition of new correction image by adding them to the
Selected Objective(s) for Acquisition list.
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5. Press Start Acquisition to initiate acquisition of correction images for the selected

combination of color channel and objective(s).

OLYMPUS

6. For each selected objective, follow the instructions provided in the live view window. A good
reference image should reflect the shading properties of the optical system and exhibit as little
distortions as possible. A homogeneous calibration sample is prerequisite for good reference
images. The optional Spatial averaging function can help to suppress small distortions of the
sample by acquiring multiple images at slightly different positions around the current field of

view and averaging these images.

O e

Addional Preparation:
Cotor Channet TaRed L. Fosus on your calibration sample

3. Press “Acquire” bo start image squridicn

Ziocus | A¥ navegation

2. Verify that the brightest spot in the image is well illuminated but not setursted

Camena

Expasure time [ms]

]
000
2800 - 1
n &
e Canne Fane (it
e 2 +
00
= -
2800 i
e i Micrescope
[ Seep size
2200 300 | [um] Filter cub
oon er cube
10
1800
i Current position
1200
5441 | [um}
10
=
w0
0
=
| o
0 om . -
= ¥ Fhusrescence w
Chppeng
[T Intensity: 100 %
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7. Select <<Darklmage>> from the list of color channels to acquire a dark image.

If correction images are available for a particular combination of color channel and objective, the
shading correction can be activated in the acquisition settings (see Chapter 4.3).
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9 Appendix

The following chapter provides additional technical information.
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9.1 Data Storage Format

All the data for a specific scan is stored in the respective storage directory defined on the Acquisition
tab of the Edit scan window. The storage scheme is as follows:

ScreenO1
Experiment_descriptor.dat
Experiment_descriptorxml
Data

——B1--W00007--PO0001 --Z00000--T00000--alexa. tif
—B1--W00007--PO0001 --Z00000--T00000--dapi.tif
B1-W00007--PO0O002--Z00000--TO0000--alexa. if

Screen01: storage directory; Experiment_descriptor.dat: position file; Experiment_descriptor.xml: scan settings file.
The system parameters are stored in the .xml file, the stage positions in the .dat file.

A Data subdirectory contains the actual image files in .tif format. Individual fields separated by a double
dash compose the image file names. These fields denote in the order of appearance the well comment
as shown in the table of the format manager, the well index, the position index, the Z-stack index, the
time loop index, and the channel name.

The names are assembled systematically as a systematic train of parameters separated by double
dashes in the following order: well name (Comment), well index, position index, Z-layer index, time loop
index and the channel name.

If shading correction images are available for the data, they will be located in the ShadingData
subdirectory.

9.2 Factory Tools

The programs described here are stored in the scan® program folder in the Acquisition subdirectory.
They are only required for system installation and configuration and neither meant nor required to be
used for daily operation.

9.2.1 LidPickup.exe

Pick-up position

The Pickup position is used when performing a scan with an autoloader. This is the position at which the
stage will move when the autoloader adds or removes the plate.

Follow these steps to set-up the pick-up position:

1. Select the frame type.
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2. Move the stage to the desired pick-up position

3. Press Set as Pickup

Pipetting position
The pipetting position is only used by the liquid handling interface, (see Chapter 9.3, Remote control)
Follow these steps to set up the pipetting position:

1. Move the objective to the center of a well and press Set well center.

2. Move the same well under the pipetting machine and press Set Pipetting position.

When the offsets are many centimeters large, it will not be possible to move every well under the
pipetting machine.

B Lid Pickup Position Setup Ié]

ATTENTION: FACTORY CALIBRATION TOOL
Inproper use might damage the System.
Joystick required for setup.

Please check Stage/Lid collision whenever moving Stage.

PN TPE SECET 3 El Select this FrameType
Pickup position Pipetting position
Adjust stage pickup position and press "Set as Pickup” Move the objective to the center of a well
and press "Set well center"
Stage X [um]
50.0 _ - Move this center of well under the pipetting machine
e Get Position - - o
- - and press "Set Pipetting Position”
Stage Y [um]
el Set as Pickup Set well center Set Pipetting Position
Pickup Position Pipetting offset
X [pm] Y [m] X offset [pum] Y offset [um]
10 10 00 00

9.2.2 LimitSetup.exe

The options described in this chapter are only available with a motorized stage controlled by a STC
controller or Tango controller.

With this program it is possible to define separate XYZ limits for each objective.

To activate or deactivate the limits in the Scan® acquisition program, check or uncheck the box Activate
the limits in Scan® acquisition.
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If the stage is not calibrated, run a stage calibration using scan® Acquisition.exe (see Chapter 8, System
Configuration)

The defaults might be used depending on the accuracy required.

Start the Program LimitSetup.exe and follow the steps as indicated on the dialog.

B Factory Limit Setup Utility x

ATTENTION: FACTORY CALIBRATION TOOL
Inproper use might damage the System.

Joystick required for s
Please check for Objectiv
moving Stage or Objecti

5. Test if the limits are OK.
1. Connect to the microscope and stage controller Initialize

Calculate and set Limits

[] Activate limits in scanR acquisition

ge collision and Stage/Lid collision whenever

2. Check the given frame lenghts. Stroke X Calculated XYZ Limits
Frame
xmin [um] min [um]
Stroke_X [um] Stroke_Y [um] 0 0
124000
DX
et — xmax [um] ymax [um] zmax [um]
P e o] Border_¥ [um] Border Z [um] J ’ L :
2800 2800 1000

L2 = L Sms Masimum XVZ Hardware Limits
Border X fcalibrated in Scan*R scquisiton)
xemin [um] ymin [am]
3. Select the objective for which you want to define XYZ limits Distance from frame 0 0
Revolver Pos. Objective smax [pm] max [um] zmax [um]
1 empt DX [um] DY [um] . = —
R [um]: Max(DX,DY DZ [um]
0 0 Pesition
[um] Y [um] Z [um]
4. Move to a frame corner, set XVZ maximurm, and press "Calculate R, DZ"
Finez z Step size [um] Current z position
50 [um] 6. If the limits are OK, press save
Save
Calculate R, DZ Set Defaults

7. Gotostep 3 for another objective

Cancel QK

1. Press the Initialize button to connect to the microscope and stage controller.

2. Check the given frame lengths: When the dialog appears the first time it will show the defaults
values for Stroke and Border. Check if these defaults are the correct ones when you compare
them with the construction drawings of the used frame in scan®. If you have more precise
values in your drawing, correct these values.

3. Select the objective for which you want to define the XYZ limits. Start with one objective for
which you want to define XYZ limits. To do that select the revolver position where the
objective is installed and select the corresponding objective from the list. You may physically
unscrew the objective and exchange it by another one if required. This step will define the
objective for which the limits are set.
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4. Move to a frame corner. This is the adjustment step for the objective. You can modify Z with
the cursors and XY with the joystick to adjust the limit position for the objective. For control
reasons the distances DX, DY are also displayed and for safety MAX(DX,DY) is taken as
Objective Radius for the limit setup.

5. Test ...This allows checking if the limits are OK. To do this, press the button Test Limits. The
hardware limits will then be applied. You can now carefully move with the joystick to check if
the objective stops at the required positions.

6. Click Save if the limits are OK. This will store the frame settings and the values R,dZ for the
specified objective in the objective list
(%ProgramData%\Olympus\OSIS\scanR\Acquisition\config\ObjectiveSettings.xml).

7. Continue at point 3 for the next objective

If an additional limit is required because of a frame or plate inserted this can be modified in the Border
Thickness Fields of the Plate format (see Edit Scan » Plate manager » Edit Plate Types; Chapter 0, ).

Frame Border x

Stroke x

Stroke y
Stage Calibration Corner x,y,z

FocalPlane- - - _ e ___

Frame Border z

Representation of the frame and objective. When setting up the limits, the objective parameters r and dZ
are evaluated and stored.
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The scanR screening system can be controlled remotely by external software, for example to
synchronize an external hardware device (e.g. a liquid handling system) with the scan® Acquisition. The
program Remote control.exe, which can be found in the scan® program folder in \Aquisition\Remote
control, allows testing the remote control functionality easily.

@ Remaote control

Commands always available

Quit
GetCominterfaceVersion
GetNumber Wells
GetMumber Subpositions
GetNumber Timeframes
GetTimeloopType

Commands available before screen

StartExperiment
SetExperimentCluster
MaveTo PlatePickupPosition
OpenllD

ClasellD

SetPlateMame

Commands available during screen

RunTo ExperimentEnd
RunTao PlateEnd

RunTo Well_XY

RunTo Well_¥YZ

RunTo Subposition_XY
RunTo Subposition_¥YZ
RunTo TimeFrame
MoveTo PipettingPosition
GetWell

StopExperiment

Command
SetExperimentCluster test2.xml

Experiment path relative to Scan Settings Library

test2.xml

Mew plate name

test2.oml

Timeframe value
0

Send

Done  Value

Deny

Error
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9.3.1 Connection to the server

The acquisition software is the server. The client connects to the server with the TCP/IP protocol on the
port defined in System » System Configuration » Remote

Only one client can connect to the acquisition software.

When not in standalone mode, and when the Edit Scan window is not opened, the server is waiting for
connection.

When a client connects, all buttons of the scan® main interface are deactivated, except for the Browse
Images button.

9.3.2 Communication interface concept

Syntax:
Client Request: [Command_name + arguments + carriage return + linefeed]
This has to be sent within 6 seconds

Server Answer: [Command_name + arguments + (OK or ERROR or DENY) + (response or error
description) + carriage return + linefeed]

DONE. The command was successfully executed

DENY. The command cannot be executed (the syntax is not correct or the time point is not correct).
When a previous command is being executed, it continues to run. When no command was being
executed, it waits for the next command.

ERROR. An error occurred while executing the command

Error descriptions:
- Command not known
- Argument not known
- Argument over range
— Screen is running
- No screen is running
- Waiting for end of previous command
- RunTo "Argument" not reached until end of experiment
- File not found
- Empty message: others errors are written in the logfile
- screen continues

screen ended

During a screen, when an error occurred, the error descriptions “screen continues” or “screen ended”
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indicate if the screen is aborted or not.

The communication is logged in the scan® Acquisition logfile, with following preceding Server/Client
TAG:

SERVER:

CLIENT:

9.3.3 Commands

Quit. The connection is closed by the server.

When a screen is running:

GetComlinterfaceVersion. Returns the interface version number
Response:

GetCominterfaceVersion DONE 3

StartExperiment UseZPrevious. Starts the experiment like the start button.

UseZPrevious:
0 -> Z dialog will pop up (if no z-position has been calibrated in plate manager)
1 -> Use previous Z, like use previous Z button
2 -> Use previous taught Z (independently of the loaded experiment file)

It returns the path of the image data directory

Responses:

StartExperiment DONE F:\Data\BDFalcon_fullwell_002

StartExperiment DENY Screen is running

StartExperiment ERROR (cancelled by user, wrong settings for example, not enough hard disc space)

When not enough hard disc space is left, the screen is aborted.

StartExperimentinversePlate UseZPrevious

Same function as StartExperiment except the plate will be expected to be rotated by 180° on the stage.
This is useful sometimes if the plate is supplied by a robot.



106

Chapter 9 — Appendix OLYMPUS

StopExperiment. It stops the experiment like the stop button.
Responses:
StopExperiment DONE

StopExperiment DENY No screen is running

SetExperimentCluster filename. Changes the current scan settings like the open button when no
screen is running

The experiment is specified by the filename. The filename is relative to the scan settings directory of the
current user, for example: %userprofile%\Documents\ScanR\Scan Settings\test.xml

Examples:

CLIENT: SetExperimentCluster test.xml
SERVER: SetExperimentCluster test.xml DONE

CLIENT: SetExperimentCluster test_not_existing.xml
SERVER: SetExperimentCluster test_not_existing.xml ERROR File not found

CLIENT: SetExperimentCluster test.xml
SERVER: SetExperimentCluster test.xml DENY Screen is running

FilterwWells list

List is a list of wells to be included, based on the wells marked as selected in the current scan settings.
Examples:

FilterWells23456 78910

Screening is restricted to the wells 2-10, even if more wells have been selected in the scan settings.
Wells not selected in the scan settings will never be screened even if listed here.

SetPlateName name

Set a different name for the current experiment than defined in the current scan settings. This also
influences the directory name where the scan is stored.

Examples:

SetPlateName Exp2153

GetNumber Argument.
Argument is one of the following:
- Wells
- Subpositions

- Timeframes
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Examples:

CLIENT: GetNumber Subpositions
SERVER: GetNumber Subpositions DONE 4

CLIENT: GetNumber Timeloops
SERVER: GetNumber Timeloops DENY Argument not known

GetWell

Returns the number of the current well (1...n)
Example:

CLIENT: GetWell

SERVER: GetWell DONE 5

RunTo Argument. Argument might be one of the following:

- ExperimentEnd

- PlateEnd
- Well_XY
- Well_XYZ

- Subposition_XY

- Subposition_XYZ

- TimeFrame Argument: number
Examples:

CLIENT: RunTo ExperimentEnd
SERVER: RunTo ExperimentEnd DONE

CLIENT: RunTo TimeFrame 6
SERVER: RunTo TimeFrame 6 DENY Argument over range

MoveTo Argument.

Argument might be one of the following:

- PlatePickupPosition. Only available before screen has started. Moves to the Plate Pickup

Chapter 9 — Appendix

Position (used for Robot) and returns to last position when the next command is received

- PipettingPosition. Only available after screen has started. Moves the Plate by a fixed
predefined XY-offset and returns to last position when the next command is received. The
Pipetting offset position is defined in the utility ./FactorySettings/LidPickup.exe . This can be

useful for transmission light imaging.
Example of responses:

MoveTo PlatePickupPosition DONE
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MoveTo PlatePickupPosition DENY Screen is running
MoveTo PipettingPosition DONE
MoveTo PipettingPosition DENY No screen is running

MoveTo PipettingPosition ERROR (pipetting position cannot be reached for example)

GetProgress

Returns the progress of the currently running screen in terms of percentage.
Example:

CLIENT: GetProgress

SERVER: GetProgress DONE 10

@ The RunTo commands are executed synchronously and new commands will not be
accepted before the RunTo command has finished. In order to query the progress for
example when RunTo PlateEnd has been started, the connection has to be closed by using
the quit command first (this will only close the connection and not influence the running
screen) and re-established then. Once re-connected, the GetProgress command will be
accepted.

9.3.4 Known use cases and corresponding communication samples

General: all setting clusters can be used in normal user mode as well. Thus they can be tested and
setup independently from the server/client mode. All data resulting from a client/server mode screen is
fully compatible and analyzable with the analysis.

A) scan®is to be fully integrated into a plate sample preparation line

1. Test the different plates and assays in scan®. Save the different setting files in the directory
‘Scan Settings Library’. Every kind of scan available in the user mode will also be available in
the server mode.

2. The user activates once the Server Mode in the GUI of scan®

3. Sample Workflow of sent messages:

Server Client

SetExperimentCluster PrefinedExperimentl

SetExperimentCluster DONE

MoveTo PlatePickupPosition

MoveTo PlatePickupPosition DONE
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StartExperiment

StartExperiment DONE

RunTo ExperimentEnd

RunTo ExperimentEnd DONE

SetExperimentCluster PrefinedExperiment2

SetExperimentCluster DONE

... and so forth

4. Analyze separately each scan in scan® analysis, i.e. no automation integration. The analysis
has to be run in batch mode or in parallel. The batch has to be fed manually.

B) Well-Time-lapse acquisition using a liquid handling automate trigger substance for starting
the time-lapse (Analogous for Subpositions or Plate Time-lapse). The liquid insertion changes
the AF layer position. Therefore AF should be performed after liquid insertion.

Example:

1. In the scan® Acquisition software execute Edit scan » Acquisition and select Loop: Well in
the Time-lapse settings box and adjust the settings.

2. Activate once the Server Mode in the GUI of scan® and communicate with the server like the
following workflow (3 wells have been selected in the scan® Acquisition GUI)

Server

Client

GetNumber Wells

GetNumber Wells DONE 3

StartExperiment

StartExperiment DONE

RunTo Well_XY

RunTo Well_XY DONE

“The automate provides the liquid”

RunTo Well_XY

RunTo Well_XY DONE

“The automate provides the liquid”

RunTo Well_XY

RunTo Well_XY DONE

RunTo ExperimentEnd
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RunTo ExperimentEnd DONE

C) Well-Time-lapse acquisition using a liquid handling automate trigger substance for starting
the time-lapse. The trigger point is time sensitive and insertion of the liquid does not change the
AF plane. It is required to make time-lapse images of the same position before and after the
insertion to observe the changes due to the insertion.

Example:

1.

In the scan® Acquisition software execute Edit scan » Acquisition and select Loop: Well in
the Time-lapse settings box and adjust the settings. Only one subposition should be
selected for the settings

Activate once the Server Mode in the GUI of scan® and communicate with the server like the
following workflow (2 wells have been selected in the scan® Acquisition GUI, the number of
time-lapse frame has been set to 40)

Server

Client

StartExperiment

StartExperiment DONE

RunTo Well_XYZ

RunTo Well_XYZ DONE

RunToTimeFrame 20

RunToTimeFrame 20 DONE

“The automate provides the liquid”

RunTo Well_XYZ

RunTo Well_XYZ DONE

RunToTimeFrame 20

RunToTimeFrame 20 DONE

“The automate provides the liquid”

RunTo Well_XYZ

RunTo Well_XY ERROR RunTo Well_XY not
reached until end of experiment

RunTo ExperimentEnd

RunTo ExperimentEnd DENY No screen is running

Not supported with the given specification are:

e Multiple ligquid insertions at a single Well/Position with subsequent interrupted time-lapse acquisition
AND AF after the second insertion step.
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e Automated Analysis takeover of time-lapse ranges (time-lapse liquid insertion points have to be
remembered and set manually in the analysis software).

e Feedback loops are only possible with considerable client programming as scans have to be stopped
and newly prepared settings have to be issued.

e Within a single scan no sequences are possible that are different from the regular sequences. In
order to change the sequence the scan has to be stopped and restarted.
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